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There is now plenty of evidence to show that teaching secondary and college level mathematics 
with dynamic software is more effective, more efficient, and above all more enjoyable (for both 
teacher and student). 

Autograph 3 leads the way in the use of dependent, selectable mathematical objects to help 
students get to grips with the basic principles of probability and statistics, and of coordinate 
geometry in both 2D and 3D. Autograph evolved in the mathematics classrooms of Oundle 
School (UK), and this 3rd version has come of age to embrace all the possibilities now offered 
by data projectors, interactive whiteboards and ‘tablet’ laptops.

There are two levels of operation, ‘Standard’ and ‘Advanced’. The ‘Standard’ level has a greatly 
simplified interface and a reduced set of options for the less experienced user.

Autograph uses the standard conventions of Windows applications with regard to multiple 
windows (called ‘pages’ in Autograph), the loading and saving of pages as files and the copying 
and pasting of text, data and graphics.

About Autograph
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First you will meet the Level Selector:

STANDARD LEVEL - this has been designed for ages 
11-16. The interface is simpler (larger icons), and you 
cannot move out of degrees into radians.

ADVANCED LEVEL - the interface embraces many more 
options for the discerning user, including calculus, prob-
ability distributions, and equations in 3D. 

If you click “Don’t show this again” you can reset this in 
“View” => “Preferences” => “General”

This is the alternative route to launch 
Autograph, and it is also the location for:
  The Autograph Help File (see p. 77)
  The Autograph Keyboard (see p. 11)
  The Autograph Manual (as a PDF file)

Launching Autograph

Installation issues are summarized 
on cards in the box, so hopefully it 
can be assumed at this point that 

Autograph is successfully installed!

To launch Autograph, 
double-click on the desktop icon, 
or you can launch Autograph from 

   Start =>  Programs => Autograph 3.20 

The HELP Menu
includes the Help file, this Manual (as a 

PDF file), and the Autograph Tutorials 
as well as a direct link to 
the Autograph Web Site.

START => PROGRAMS => Autograph 3

THE HELP MENU
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Standard and Advanced Levels

Both levels open 
up first with a 

2D graphing page, 
showing three toolbars: 

the MAIN, the 2D GRAPHING 
and the MODES toolbars

STATUS BAR 
This shows dynamic information about the currently 
selected objects, e.g. coordinates, equations.
This information is offered when you open a Text Box.
To show the information in a larger free-floating Status 
Box double-click on the bar. To hide the bar, go to the 
View menu and untick “Show Status Bar”.

“Degrees/Radians”
In the Standard level, 
this just says “Standard”. 
In Advanced level, this 
indicates “Radians” or 
Degrees”, as set locally in 
“Page” => “Edit Settings”.

“4 s.f”
This indicates the 
accuracy currently being 
used for all results, 
coordinates, etc. Go to 
“Page” => “Edit Settings” 
to amend locally.

MODES
toolbar

(Advanced)

2D
toolbar

MAIN
toolbar

MODES
toolbar

(Standard)
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The Main and the Modes Toolbars

THE MAIN TOOLBAR

 Add new 1D Statistics Page
 Add new 2D Graphing Page
 Add new 3D Graphing Page

 Open new Autograph file (.agg) [or FILE menu]

 Save current page as .agg file [or FILE menu]

 Undo [Ctrl-Z]. Also: Redo [Ctrl-Y]

 Equation/Object key at the bottom 

 Equation/Object key at the side

 Integer snap [Standard level only]

 0.1 snap [default in the Advanced level]

THE MODES TOOLBAR

  SELECT MODE. Selects, when over an object.
 Otherwise:
2D: Drag a rectangle round points to select them.
3D: Acts the same as the Drag mode.

 ESC will always return you to this mode. 
 ESC again deselects current selection.
 Pressing ‘.’ will temporarily put you in ‘Point’
 mode while you hold it down, then return you to
 ‘Select’ mode - useful for placing single points.
 ______________________________________

  POINT MODE: place free points, or on objects

  + Ctrl:  Finds intersections at f(x)=0 or f(x)=g(x).
 The mouse changes to a small circle when over
 an intersection.
 ______________________________________

   SCRIBBLE MODE: generates writing objects 
 which can be selected (to change colour, thicken, 
 delete, etc). [Not available in 3D.]

    RUB-OUT: like a board rubber - everything
 in its path is deleted. Use Ctrl-Z (undo) to bring 
 them back!

    DRAG MODE. 
1,2D: Drags the whole axes; everything is redrawn.
3D: Rotates the scene 
 + Ctrl:  UP/DN: moves the ‘camera’ in and out
 + Shift: moves the ‘camera’ about.
 ______________________________________

  ZOOM-in  (centred where you click) 

  ZOOM-out  (centred where you click) 

   Rectangle ZOOM in [not available in 3D].

 The full set of zoom modes is available in the
 Standard level from the ‘Axes’ menu => ‘Zoom
 Modes’ 

More on the Advanced Level Modes Toolbar:
 

        3D:     
 ZOOM in/out in one direction only: ‘x’, ‘y’ 
 or ‘z’ (3D only).

   Rectangle Zoom OUT: putting the whole scene
 into the drawn rectangle [not available in 3D].

 This tool turns on automatically when solving a
 differential equation or integral function.

   Angles in degrees, radians [Advanced only]

 RESULTS BOX (a text file of recent results) 

 History of equations (2D and 3D)

 EDIT AXES  (see p. 12)

 TEXT BOX (offers text from the Status Bar)

 MODES TOOLBAR on/off

 CONSTANT CONTROLLER (see p. 14)

 ANIMATION CONTROLLER (see p. 15)

 WHITEBOARD MODE (see p. 11)

 Line thickness (of selected object)

 Line colour (of selected object)

 Fill colour (of selected object)
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The Autograph Menus 

FILE MENU
  New 1D Statistics Page

   See page 21

 New 2D Graphing Page
   See page 39

 New 3D Graphing Page
   See page 65

 New Extras Page: 

  Area of Circle
  Trigonometry
  Dice Simulation
  Monte Carlo
  Confidence Intervals
  Poisson Grid
   See page 82

 Open (saved .agg file)
 ○ Close (current page)

 Save  ... ... [Ctrl-S]
 ○ Save As

 Print Preview
 Print  ... [Ctrl-P]

 ○ Print Setup
 Refers to the current page

 Exit

NOTE: AUTOGRAPH FILES (.agg):

 To save any 1D, 2D or 3D 
Autograph page (file extension 
“.agg”) use “File” => “Save” [Ctrl-S] 
or “Save As”, or the “Save” icon on 
the main toolbar.

 To load a “.agg” file either 
double-click on it (to start up 
Autograph if it is not already 
running), or drag it onto an open 
Autograph window, or use “File” => 
“Open”.

Autograph v.2 saved its files in two 
separate formats: 

  2D Graph files: “.agg”,

  1D Statistics files: “.ags”

Both types can be loaded into V.3, 
but files saved from V.3 are all “.agg” 
files. V.3 files will not load into V.2.

_____________________________

EDIT MENU

 Undo  ... ... [Ctrl-Z]
 Redo  ... ... [Ctrl-Y]

 
There is unlimited Undo/Redo for 
each page that is open.
 
 ○ Select All Points
 ○ Select All Scribbles
 ○ Select All Objects  [Ctrl-A]

_____________________________

VIEW MENU

 Constant Controller
   See page 14

 Animation Controller
   See page 15

 ○ Status Bar (on by default) 
 ○ Status Box
   See page 16

 Results Box
   See page 16

 ○ Instructions Window
 A page of instructions as edited
 and saved in 
 “Page” => “Edit Instructions”

 Onscreen Keyboard
    See page 11

 ○ Toolbars
 ○ Load/Save Toolbars

Operation of the toolbars is
automatic, and they are generally 
best left alone! However you can use 
these options to select, customize 
and reset the toolbars.  You can 
load and save particular toolbar 
arrangements.

 ○ Preferences
   See page 10

_____________________________

PAGE MENU

 ○ Edit Settings 
All these settings are local to 
the current page. You can name 
the page, associate a file as the 
Instructions page, set the angle 
units [Advanced only], and set the 
accuracy (default 4 sig fig).

 ○ Edit Instructions
You can create and save a page of 
instructions for the current page.
 
 ○ Reset Page 
A list of all the reset options on the  
Statistics, 2D and 3D page toolbars. 
 
 ○ Copy Page (Bitmap) [Ctrl-C]
Places the graphing area and key 
onto the clipboard, This can be a 
large file, so it is better to reduce the 
Autograph window size first.

 ○ Copy Graph (Metafile)
This copies the graphing area as a 
high quality ‘vector’ image to paste 
into Word. [Not available in 3D.]

 ○ Copy Equations (text)
 ○ Copy Status Bar (text)
 ○ Save Page (bitmap)
 ○ Save Graph (metafile)
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AXES MENU

 Edit Axes
   See page 12

 ○ Snap Settings 

Use this to set up how a point moves 
when its position is altered using 
the arrow keys. The default settings 
should suffice for most situations.

 ○ Zoom Modes

The full set of zoom modes are listed 
here, the same as on the Advanced 
Modes toolbar. Not all are in the 
Standard Level Modes toolbar, but 
all are available in both levels

 Move Origin
Moves the origin to where you click.

 Move Centre
Moves the centre of the page to 
where you click.

 Select Mode
ESC will return you to this state.

 Point Mode

 ○ Show/Hide Equation Key.

Use this if the key is unnecessary, or 
to retrieve it. This option has been 
added to the ‘key’ right-click menu.

_____________________________

DATA MENU

 Enter XY Data
 See page 52

 Enter Coordinates
 See page 42

 Enter Shape
   See page 50

 Enter Grouped Data
 Enter Raw Data

   See page 25

 Enter Box and Whisker Diag.
   See page 28

 Enter Probability Distribution
   See page 33

_____________________________

EQUATION MENU

This is a duplicate of the right-
click menu when the mouse is 
over the Equation Key on a 2D or 
3D Graph page.

 Enter Equation ...  [Enter]
 Edit Equation 

   See page 54

 Delete Current Equation 

 Delete All but current
 Delete All Equations

 Function Definitions
   See page 54

 Manage Equation List

Here you can add, delete and edit 
equations in the list. You can also 
paste from the History list, and 
choose to hide/unhide equations.

 View History

This lists all 2D/3D equations that 
have been plotted in the current 
session. Any selection from the list 
can be plotted.

 ○ Create (current equation):

  Gradient Function
   Integral Function
   Reflection in y=x
   See page 57

_____________________________

OBJECT MENU 
[= Right-click Menu]

This is a duplicate of the main 
graphing area Right-Click menu, 
which lists the appropriate options for 
the objects selected on the current 
page. This is useful when working on 
an Interactive Whiteboard, or on a 
Mac computer (using ‘Virtual PC’).

_____________________________

WINDOW MENU
 ○ Tabbed Workspace 
 [ticked ON by default]

 Cascade  ... ... ... F5
 Tile Vertically  ... ... F6
 Tile Horizontally  ... ... F7

 ○ Arrange Icons ... ...
 ○ Close All  ... ...

 ○ List of open windows 
    browse:  F8 <=> F9

_____________________________

HELP MENU

 Help Contents  ... ... F1
   See page 77
 ○ Autograph Manual (PDF) F2
 ○ Autograph Resources  F3
   See page 79
 ○ Autograph Web Site  ... F4
 ○ About Autograph 
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Before you get going, look at the Preferences (in the 
‘View’ menu) and check that they are set up the way 
you want them. There are four “TABs”:

♦ PLOTTING
 

Options
Older computers will struggle with Autograph’s 
sophisticated plotting style which makes lines appear 
smooth.  You can try switching to ‘Normal’ or, for really 
old machines, to ‘Fast’.
 

Line Thickness
Use “Thick Lines” for demonstration work. 2¼ pt is a 
useful thickness, applying to all graphs and lines.

♦ GENERAL
Inequalities
Set the shading you prefer for illustrating inequalities.
 
Level
This is the path to switch between “Standard”
and “Advanced” without restarting Autograph.
 

Options
Show Level Selector: This is how to ensure that the 
level selector shows on start-up.
Disable Unhide Equations: This disables the ‘Unhide’ 
option in Equation => Manage List.
Accuracy: this starts at 4 sig. fig., but can be reset here
as the start accuracy for all pages opened by this user.

TO SHIFT OR NOT TO SHIFT?
 

It is standard Windows practice to use the SHIFT key 
to enable the selection of more than one object on the 
screen.  With the advent of Interactive Whiteboards, 
it is more sensible to accumulate selections without 
pressing Shift. The default setting is to use “Shift”.  
Tick the box here to apply “No Shift” to all pages.
 

The downside of “no shift” is that any previous selection 
may still be active. It is recommended therefore before 
any new selection, you click on the graph area to de-
select any residual selection [pressing “Escape” also 
does this].

♦  WHITEBOARD 
Here you set the Whiteboard Mode preferences. Note: 
the default is “No Shift for Multiple Select” when in 
Whiteboard Mode.

Checking your Preferences

If a 3D window will not 
open (eg “insufficient 
memory”) this tab 
allows the 3D graphing 
quality to be reduced to 
free up some memory.
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Using an Interactive Whiteboard

There are two main types of projector-driven Interactive Whiteboards. Both provide 
teachers with a large screen which they can control directly while standing at the board:

1. Pressure Sensitive Boards (e.g. ‘Smart’ Boards from Canada)
Nothing happens until the board is pressed, so there is no helpful ‘mouse cursor’, but it 
has the advantage that anything can act as your ‘pen’, e.g. your finger, a drumstick, etc. 
Right-click is achieved by pressing a button on the tray, then tapping on the board. The 
lack of mouse cursor suggests that there will be times when a regular keyboard and 
mouse should be used for constructions, then go to the board for any animations.

2. Boards, Graphics Tablets, or ‘Tablet’ PC laptops with an electronic ‘pen’ 
These use a pen which broadcasts its position to the screen, and you get the important 
‘mouse cursor’.  Right click is achieved by pressing a button on the side of the pen.  
Tablets allow the teacher to control the image from anywhere in the classroom, 
including handing over to the pupils.

Autograph’s IWB friendly features:

 WHITEBOARD MODE - click on this to switch on:
 - No Shift for Multiple Select - Display Keyboard - Whiteboard Theme (larger letters, thicker axes)
 - All thick Lines, all as set in “View” => “Preferences” => “Whiteboard”.

 SCRIBBLE MODE - this will add writing directly to the graphing page. This is much better than  
 an IWB writing tool: it does not disappear on switching back, and it ‘belongs’ to the page, so will
 rescale if the axes are altered. Select a scribble by clicking on it, or use “Edit” => “Select all
 Scribbles”, to drag, change colour or thickness, or delete the writing.

 RUBOUT TOOL - use this as you would a board rubber. Any object it touches will be deleted. 
 Anything you delete in error can be revived using “Edit” => “Undo”, or Ctrl-Z.

 ON-SCREEN KEYBOARD - this can be turned on and off in “View” => “Keyboard”.
 With its minimum configuration (right) you can manipulate points, objects and selections. “Shift”
 and “Ctrl” stay set until cancelled. Use “Esc” to return to the “Select” Mode, and “Esc” again to
 clear any object selection. “PgUp” and “PgDn” are used in the Constant Controller to
 switch between constants. “Undo” is included, so is “PtSc” which copies a bitmap of the screen.

Data designed for data entry and axis ranges: includes π , TAB and – (minus) and comma (for lists)

Text designed to include common mathematical symbols and to eliminate the need for “Shift”. 
 Keys such as “<”, “>”, “+”, “(”, “)” are all Shift keys, so these have their own buttons, along with
 “sin”, “cos”, “tan”, some common indices (including –1, used for inverse sin, etc.) and symbols.

Extra The Keyboard uses “Arial for
 Autograph Uni” font (see p.80).
 The ‘extras’ includes Greek
 letters that can also be used
 in an Equation as constants.
 
 e.g.:
 Text:  (, ),  ∫sin²θ dθ 
 Equation:  y = sin(x + α)
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  EDIT AXES   - There are many ways to customize the Autograph pages, and what is described here is much  
the same for 1D, 2D or 3D pages.

RANGES TAB: this allows the min and max values and 
pip spacing to be set automatically or manually.
Pressing any of the four buttons shows the resulting 
scales on offer, so you can check before you “OK”.

 Use the DEFAULT SCALES button to set 
appropriate scales for what is plotted (same as 
“Intelligent Ranges”). In particular for 2D trig functions, 
the scales respond to the degrees/radians setting.

LABELS TAB: Labels can be any text.
The variables can be any single letter e.g. ‘v’, ‘Velocity 
(ms-1)’ and ‘t’, ‘Time (s)’, when equations such as v = 
2t(1 − t) can be entered.

 This 2D toolbar button sets ‘x’ to ‘t’ and ‘y’ to ‘x’.  

 This 2D toolbar hides the ‘y’ axes to turn the ‘x’ axis 
into a number line.

OPTIONS TAB:  
Axes - use “Hide ⇑” in 1D to take off the ‘f’ axis (eg Box 
and Whisker), in 2D for number-line work.
Grid - use “sub-division” for the graph-paper effect.
Key - use this to control the equation key.

3D: is set “Always Outside” by default.

APPEARANCE TAB:
Here you have complete control over the font in use, 
the colour of the axes and grid, and the background 
colour. Use the presets to instantly set up a range of 
settings, e.g. “Graph Paper”.

3D: this tab includes control over transparency.

Sorting Out the Axes
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1D: The default axes for displaying data. The key has 
two sections, one for data sets, one for objects.

1D: Axes for displaying probability distributions. The 
labels are changed automatically, but can be edited. 

2D: Axes for displaying 2D graphs. The key has been 
turned off (“View” menu).

2D: Using the “Default Axes” button for a trigonometric 
graph, puts in π scales when angles are in Radians.

2D: A polar graph using a polar grid, π scales, and 
equal aspect.

3D: A bounding cube is shown. The background is 
black by default, but can be made lighter.
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The Constant Controller

  The CONSTANT CONTROLLER
 is used in 2D and 3D pages to control 
 constants that have been included in:
Equations, e.g.: y = mx + c, coordinates of 
points, e.g. (a, b), vectors, etc.
Permissible constants include all the available 
Greek letters, and all normal letters apart from:
‘e’  [reserved for the exponential constant]
‘i’ and ‘j’ [reserved for complex numbers] ‘t’ or ’θ’ 
may be used when they are not parameters.

The constant controller ‘belongs’ to a page, and 
controls all constants on that page. Constants 
can each occur more than once and in more 
than one equation or object. 
Values of a selected constant are best 
controlled dynamically by the UP/DOWN arrow 
keys, and the step by the LEFT/RIGHT keys.

List of constants
Use the arrow, 
or PgUp/PgDn

to switch between them

Control the VALUE
of the current constant

with these buttons
or ⇑, ⇓ (ARROWS)

Control the STEP 
with these buttons
or ⇐, ⇒ (ARROWS)

OPTIONS
Manual: direct control of one constant at a time.

Family Plot: this affects constants in 2D graphs only.
You can set any number of graphs to plot at the same time with 
a range of values, including a comma-separated set, of the 
chosen constant.

Animation: an animation of the constant can be set up, and 
this can apply to constants in 2D or 3D equations, and in 
coordinates and vectors in 2D and 3D.

 With an animation set up the control
 buttons change to ‘Go/Pause’ and ‘Stop’.
 The pair at the left end are used when a
 number of animations are set up, so you
 can start them all off at the same time.

The current 
VALUE

The current 
STEP

A family of curves drawn from y = asinx,
using the constant controller “Family” option.



www.autograph-maths.com 15

The Animation Controller

  The ANIMATION CONTROLLER
 is used to animate the parameter(s)
 of an operation, for example:

1D: ‘n’ and ‘p’ for a binomial distribution
 the class width for a grouped data set
2D:  transformation, enlargement scale factor
 transformation, rotation angle 
 x-coordinate of a point [y=f(x) graph]
 t-coordinate of a point [parametric graph]
3D:  transformation, enlargement factor
 t-coordinate of a point [parametric graph].

To set up an animation, select an object that 
has the factor or parameter (e.g. an enlarged 

shape). Click on the  button, which will light 
up for all objects that can be animated.

You can control
the VALUE of the current 
animation manually with 

these buttons

or you can
control the animation from 

the keyboard using ARROW keys:

⇑, ⇓ (VALUE)
and ⇐, ⇒ (STEP)

ANIMATE
Manual: direct control of one value at a time.

Automatic - repeat: this will animate from the start value to the 
finish value, then jump back to the start.

Automatic - Up/Down: this will smoothly animate up and down 
the value set.

  With an animation set up the control 
  buttons change to ‘Go/Pause’ and ‘Stop’. 

NOTE: another way to achieve an animation is to put a 
constant in as the ‘factor’ (e.g. enlargement factor), and use the 
constant controller animation feature. (The ‘family’ option is only 
available for constants that are in equations.)

A family of normals drawn to y = sinx, using
the “Evolute” option on the selected graph.
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The Results Box and Status Box

 THE RESULTS BOX

The Results box resides in a TAB on the right side by default. If it has 
been closed you can launch it by pressing the toolbar button, or using 
“View” => Results Box”. 

Sometimes the results box is opened by some other action (eg “Transfer 
to Results Box” or “Display Information”), or you can click on the TAB to 
open it - it will slide open and not disturb the graphing area, revealing 
its contents. It will remain open until you click somewhere else. Its left 
boundary can be dragged to the left or right to vary its width as required.

If you click the pin icon, you turn it into a dockable window box
- Drag its blue bar to make it float, or ‘dock’ on another edge of the graph 
area
- Double-click on the blue bar to toggle its position between ‘docked’ and 
‘floating’. However you leave it will be remembered next time to start up.

The results box is a general repository for answers to calculations (eg 
intersections) and statistics results. It is all created in the resident ‘Arial for 
Autograph Uni’ font. 

Any selected text in the box can be copied out to another application (eg 
Word). When pasted, all formatting and font information is preserved. You 
can use the right-click option “Clear All” to empty its contents, though this 
is not usually necessary.

1D Results that are put in automatically include:
Table of Statistics or Probabilities 
 

1D Results that are put in manually include:
Statistics Box (click “Transfer to Results Box”)
 

2D Results that are put in automatically include:
Equations of lines (tangents, normals, segments, etc)
 

2D Results that are put in manually include:
Selected graph:  option “Display Information”
 

3D Results that are put in automatically include:
Intersections: two lines, two planes, three planes.

THE STATUS BOX

To view the contents of the Status Bar in a moveable and resizable window and with a larger typeface, either double-
click on the Status Bar, or use “View” => “Status Box”.  To close the window, double-click on it or click the cross.

The example here shows the dynamic information from a gradient triangle, to 8 d.p. (set in “Page” => “Edit Settings”).

_____________________ 
 
Slope: 0  
∆y=0, ∆x=1   y=2
_____________________ 
 
Vertical Line: x = –1 
_____________________ 
 
Slope: -1 ∆y=1, ∆x=1  
y = –x – 2 
_____________________ 

Table of Values of Raw Data
Class Int.   Mid. Int.      f
0 ≤ x ≤ 9      4.5   0 
10 ≤ x ≤ 19    14.5   0
20 ≤ x ≤ 29    24.5   1
30 ≤ x ≤ 39    34.5   6
40 ≤ x ≤ 49    44.5 43
50 ≤ x ≤ 59    54.5 42
60 ≤ x ≤ 69    64.5   8
70 ≤ x ≤ 79    74.5   0
80 ≤ x ≤ 89    84.5   0
90 ≤ x ≤ 99    94.5   0

∑f = 100
∑fx = 4950
∑fx² = 250900
Mean = 49.5
Standard Deviation = 7.681
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The text from the Status Bar placed in the text box 
when it is opened. This can, of course, be edited as 
required.

Layout, Font and Frame can all be edited to the usual 
Windows conventions (including gradient fill), and a 
number of preset layouts are provided (e.g. “Deep 
Blue”, used below and the opening ‘default’ style).

• Set as Default: This will make your current text box 
style the default style, and therefore the style of the next 
box to be created.

Adding a Text Box

The yellow diamond can be 
dragged to form an arrow.

 TEXT BOX (Static Text)
Use the right-click option or click on the icon in the 
main toolbar.  Due to the restrictions of Direct-X it is not 
possible to put a text box on a 3D page.

 TEXT BOX (Dynamic Text)
 
With a single object selected, the text box allows you create a label 
with text that ‘belongs’ to the object (as in the Status Bar, though 
this often contains the details of more than one object).  The text 
box can contain two types of text:  

- the Static part, which appears in black and is fully editable, and 
- the Dynamic part, which appears in red between {{...}}. This text 
will change dynamically if the object is moved or edited in any way.

• Remove Object Text / Insert Object text
This removes or inserts the dyanmic part of the status bar text

• Convert to Static Text
This converts the red text to static, fully editable text.

• Show Detailed Object Text
This shows dynamic values of any associated constants in use.

• Anchoring [only relevant for points]
Anchor to the object, or not, and set the distance from the object .
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Edit Draw Options

Most objects can have their appearance defined by this 
dialogue box, from the Right-click menu for one or more 
selected objects.

If more than one object is selected all objects will be 
forced to take the same style. 

LINE STYLE:
This can be applied to any object which is, or contains, 
a line.
 

Line Thickness:  

This can also be set by  on the main toolbar

Dash Style: 
 

 
This can be applied to any graph or line or vector
 
Line Colour:  

This can also be set by  on the main toolbar.

 
FILL STYLE: (eg Shapes and Histograms) 

Fill Colour 1:  

This can also be set by   on the main toolbar
 

Fill Colour 2:  
This provides the second colour if “Gradient Fill” is 
ticked.  [not available on a 3D page] 
 

Angle:  
This sets the angle of the gradient fill.
 

Transparency:  
Set the % using the slider or by entering a value. 
0% = solid; 100% = fully tranparent.

HIDE / UNHIDE OBJECTS

Hide: One or more selected objects can be hidden, 
using the right-click option “Hide”

Unhide: If you can find and select a hidden object, 
you can use the right-click option “Unhide object”

Unhide All: This right-click option will unhide all 
hidden objects.
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USING AUTOGRAPH: SOME BASIC PRINCIPLES

Use the RIGHT-CLICK menu:
 - to create top level objects (e.g. a graph).
 - to find the appropriate operation to carry out on the current object selection.

Selections: with or without SHIFT:
 - check this out in “View” => “Preferences”. 

 - The default is to use SHIFT for multiple selections, except when in Whiteboard mode 

The MODES toolbar: get in the habit of returning to the SELECT mode. 

 - Either click on  or press ESC. Pressing ESC again also deselects any outstanding object selections.

A couple of useful features using the CTRL key:
 - 2D Point mode:   + CTRL enables a point to be placed at an INTERSECTION, either f(x) = 0 or f(x) = g(x)

 - 3D DRAG mode:  + CTRL zooms the camera IN and OUT as you move the mouse UP and DOWN.

Creating an Instructions Page

Use Page menu => Edit Instructions. All the Autograph 
characters are available. There is font control [though the Arial 
for Autograph font is required if the symbols are used] and 
formatting control (left/centred/right).

Use File => Save, and wherever this Instructions file is saved, 
it will be associated with the current Autograph File (if it is also 
saved). When the current Autograph file is reloaded, users 
can reload and view the associated Instructions file, using 
“View => Instructions Window”.

You can also check where the Instructions file is located in the 
Page Menu => Edit Settings.

By default the Instructions Page opens in a 
“docked” position on the right side. You can 
control the position as follows:

- Click the pin icon to minimise to a tab
- Click on the tab to maximise again
- Drag its blue bar to make it float, or ‘dock’ 
on another edge of the graph area
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 ƴ
1D PAGE: Statistics and Probability
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1D: Standard and Advanced

MAIN
toolbar

1D
toolbar

The 1D page opens 
with the 1D Toolbar

and this standard x-f axes

When the first object is created (e.g. a 
histogram or a probability distribution) 
the axes are auto-scaled and labelled 

appropriately.

DATA KEY
This is where the data sets are listed

STATISTICS OBJECTS KEY
This is where the objects are listed

THE 1D PAGE: 
The TOP LEVEL 

RIGHT CLICK MENU

♦  Enter Grouped Data
 Set up the class intervals for a grouped data set. Frequencies are
 either entered manually, or calculated from underlying raw data.

♦  Enter Raw Data
 Enter or paste raw data, or generate it from one of Autograph’s 
 built-in probability distributions.

♦ Enter Box and Whisker Diagram
 You can create a box and whisker from its five elements: 
 Minimum, Lower Quartile, Median, Upper Quartile, Maximum.

♦ Enter Probability Distribution [Advanced Level only]
 A selection of discrete and continuous distributions.

♦ Text Box
 Place a text box on the graphing area.
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1D: Statistics Toolbar

THE 1D STATISTICS TOOLBAR

  Re-label axes, frequency: f - x

  Re-label axes, cumulative frequency: F - x

   Re-label axes, continuous PDF: f(x) - x

   Re-label axes, percentiles: % - x

  Re-label axes, probability: p - r
 These options offer a quick way to get the right
 axes labels, also possible through Edit Axes. 
 New statistics objects automatically get the right 
 labels and ranges when they are first drawn.
 

 Auto-scale: use this when required.
 This option will also re-label as appropriate.
 

  Interpret current data set as discrete data

   Interpret current data set as continuous data
 These buttons are not on the Standard level, but
 you can set in the grouped data dialogue box.

 Add Grouped Data
 Add Raw Data
 Add Box and Whisker plot
 Add Probability Distribution

 As featured on the top level Right-Click Menu

 Draw Histogram 
 - from grouped data

 Draw Cumulative Frequency Diagram
 - from grouped data

 Draw Box and Whisker plot 
 - from raw or grouped data 

 Draw Dot Plot 
 - from raw data

 Sampling from raw data [Advanced level only]

 Show mean and 3 SD
 - puts pips on the ‘x’ axes

 Draw Line Plot 
 - from discrete grouped data

 Draw Moving Average 
 - from a Line Plot

 Histogram area calculation
 Cumulative Frequency calculation
 Probability distr. calculation [Advanced only]

 Table of Statistics 
 - from grouped data

 Comparison of Raw and Grouped statistics
 Stem and Leaf Diagram 

 - from grouped raw data

THE DATA KEY (on the left) and OBJECTS KEY (on the right)

The DATA KEY lists all the datasets that may have been entered. If there is more than one data set, you can click on 
any one to make it the ‘current’ dataset, for which objects can be created. Each data set has a symbol to show what 
type it is (see below). To EDIT a data set, double-click on it in this list.

The OBJECTS KEY on the right lists the objects that have been created from the currently selected data set. Only one 
can be the current object, either by selection here or by clicking on the object itself in the graphing area. 

KEY:   Raw Data entered   Grouped Data created    Grouped data entered
  not grouped  from underlying raw data   no underlying raw data
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          GROUPED DATA SET

♦ Name: Enter the name as it will appear in the Data Set key.
____________________________________________________

CLASS INTERVALS - choose one of the three options:

♦ Enter Min, Max and Class Width
The convention adopted is a ≤ x < b. If the final value of the final 
class is needed tick “Include extra class”.  If there is underlying 
raw data, intelligent suggestions are available automatically.

 The class width can be varied using the animation controller.

♦ Integer Data
Use this if the classes are all integers enter, e.g. Lotto frequencies 
(1-49), or dice scores (1-6). Equivalent to a class width = 1.

♦ Enter manually (left limits and final)
This is the chance to enter unequal class intervals.

Recalculate
Click here to show the actual intervals that are being used.
____________________________________________________

FREQUENCIES - choose one of the two options:

♦ Use Raw Data
This will open the Edit Raw Data Set box, and the data from that 
will form the underlying data for this Grouped set. Frequencies will 
be calculated automatically according to the class intervals used.

♦ Enter Manually (comma separated)
Enter as many frequencies as there are classes.

Recalculate (with underlying Raw data only)
Click here to show the actual frequencies that are being 
calculated from the classes that have been entered (or amended).

1D: Adding a Grouped Data Set

 The Edit Grouped Data Set dialogue box
 - with or without an underlying raw data set.

♦ USE (x,f) TABLE 
This will enter classes and frequencies in column form. The ‘x’ 
column represents the start of each group, and the (optional) final 
value is the end of the last group. These two columns can be pasted 
from a spreadsheet, and any text in the first row will become the 
column headers (“2-Dice scores” and “f” in the example).        .

The headers can be edited (right-click option), and used as the 
data set name and x-axis label .
Memory/Recall: store and recall the current values
Integers (1...n): replaces the ‘x’ column with 1,2,3,... 
This is useful, e.g., for Quarterly Data.     
Import/Export: CSV file format.

DATA TYPE

♦ Continuous: classes will be plotted at 
their exact value.

♦ Discrete, by entered unit (e.g. 1): 
classes will be plotted shifted to the left 
by the unit/2. Required for a Line Plot.
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          RAW DATA SET 

♦ Either: Enter the data one at a time, separated by “Enter”.

♦ Or: Click on the top cell and paste a single column of data 
from a spreadsheet. If the top row is text, this will be taken as the 
“column header”. 

♦ Or: use Import - Export
A single column of data can be imported from a saved CSV file 
(comma-separated value), which is compatible with Excel.
____________________________________________________

SCALE OPTIONS
Enter any f(x) formula here. Click “Scale-x” to scale the data.

COLUMN HEADER
Here you can use the header as the Data Set Name, and the 
x-axis label when plotted. Hover over the column of data and use 
the right-click option to enter/edit the “column header”.

MANAGING THE RAW DATA
Use “Memory”, “Recall”, “Clear Data” and “Sort by x” as 
required.
____________________________________________________

To Group a Raw Data set........
You can reach this “Edit Raw Data” box as part of “Edit Group 
Data”, or you can later use the right-click option “Group Data Set”.

1D: Adding a Raw Data Set

  The Edit Raw Data Set dialogue box
 - can be grouped or remain ungrouped.

DISCRETE DISTRIBUTIONS
Select Edit Default Mean, Variance
Rectangular Enter a, b r = 1, 2 ... 6 μ  = (a + b)/2
   σ² = (b–a)(b–a+2)/12 
Binomial Enter n, p B(10, 0.5) μ  = np, σ² = npq 
Poisson Enter m Poi(4) μ  = σ² = m
Geometric Enter p G(0.5) μ  = 1/p, σ² = q/p²
User Defined Enter p(0), p(1), ... p(r) 

CONTINUOUS DISTRIBUTIONS
Select Edit Default Mean, Variance
Rectangular Enter a, b –2 ≤ x < 2 μ  = (a + b)/2 
    σ² = (a – b)²/12 
Normal Enter μ, σ N(0, 1)
f(x) Enter f(x) and optional g(x), and ranges
   f(x) = x² range: –2 ≤ x < 2

More than one sample can be ‘mixed’, e.g. to produce a bi-modal 
data set.

SAMPLE DATA
Here you can create samples from any of 
Autograph’s built-in probability distributions.

♦ Sample size (max 5000)
♦ Select Distribution, then Edit Distribution
♦ Create sample
The data will be added to any data already in 
the column. 

DATA OUT
Hover over the column and use the right-
click options: “Select All” (Ctrl-A), then 
“Copy” (Ctrl-C), then paste elsewhere.
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1D: Histogram

 HISTOGRAM

    A Histogram, plotting frequency or frequency 
density against ‘x’, can be created from any grouped 
data set (with or without underlying raw data).

♦ Frequency Density
Choose ‘frequency density’ and enter a ‘unit’.
Unit = 1  ⇒ the total area under the histogram = n. 
Unit = 1/n  ⇒ the area = 1 (relative frequency diagram).

♦ Plot up/down
A good opportunity to compare two similar histograms. 
Use Autoscale to adjust the axes accordingly.

♦ Draw Frequency Polygon
This joins the upper mid-points of each class interval 
to form a polygon. To extend at both ends to zero it 
is necessary to have one ‘spare’ class at each end. 
Double-click on the data set name to return to the Edit 
Grouped Data box to extend the range of the classes. 
____________________________________________

  Continuous      Discrete

These two buttons are on the Advanced toolbar, but this 
choice is available in the Grouped Data dialogue box. In 
the 1D Statistics page, when histograms are plotted the 
‘x’ scale is always continuous, so the following applies: 

The convention adopted by Autograph is that the 
class interval a-b is represented by a ≤ x < b. When 
the variables are being plotted as discrete, of unit 
m (usually m = 1), the interval a-b is represented by 
a–m/2 ≤ x < b–m/2. With m=1, the effect of switching to 
discrete is to move the whole diagram to the left by 0.5.

Two histograms back-to-back, one of them using 
the option “plot down”. Use “Autoscale” option 

to create appropriate scales easily.

Two views of a data set with unequal class intervals: 
0, 40, 50, 55, 60, 100.  When  the frequency density 
unit is set to ‘1’ the histogram shrinks to an Area = n.

A histogram for a grouped data set (with underlying 
raw data), together with a Frequency Polygon. 

Use Edit Draw Options to control its appearance.
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ROUTES TO ENTERING RAW DATA

If you know you want your raw data grouped (eg to 
draw a Histogram or Cumulative Frequency Diagram):

 “Enter Grouped Data” - this dialogue box can 
create grouped data with underlying raw data (    ) or 
without (    ). It includes the option “Use Raw Data”, 
which opens a dependent “Edit Raw Data” dialogue 
box, after which sensible default classes are offered.

Otherwise, to enter raw data on its own (e.g. to draw a 
Dot Plot or Box and Whisker Diagram):

 “Enter Raw Data” - this dialogue box allows a raw 
data set (    ) to be created which is not grouped. To 
group this data subsequently, use the right-click option 
“Group data set”.

 Histogram “Probability by Area” calculation.

To use the toolbar button or right-click option, make 
sure the histogram is selected in the right key list, or 
click on the histogram itself.  In the dialogue box, enter 
range, or left or right cumulative limits.  In the status 
bar, the probability and the frequency in the resulting 
region are given. 

In this example: the probability and frequency for the 
range 55 ≤ x ≤ 75 are given. The yellow ‘diamonds’ can 
be dragged to vary the range dynamically.

  If the data set is grouped with regular classes, the 
class width can be animated (or altered manually in 
the Edit Grouped Data dialogue box: double-click on 
the data set in the left key list).

Class width
= 25

Class width
= 15

Class width
= 5

Class width
= 1
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1D: CFD and Box Plots

 CUMULATIVE FREQUENCY DIAGRAM

          The CFD option is available for any grouped data 
(with or without underlying raw data). 

♦ Settings
Cumulative Frequency – uses the frequency scale of 
the vertical axis
Percentiles – converts so that max. frequency = 100%

Plotting :
Curve fit: fits quadratics through three points at a time
Curve Tightness: 0% is the loosest, 100% is straight 
line segments
Linear Fit: straight line segments

 CFD MEASUREMENT
 

♦ Settings
Choose the horizontal line: LQ (25%), Median (50%), 
UQ (75%), or User Defined (enter value of ‘F’).
Choose the vertical line (default is near the minimum 
‘x’ value). 

Once drawn, both lines have a small yellow diamond 
which can be dragged as required to intersect on the 
CFD.

  BOX AND WHISKER DIAGRAM   

Data Source

This diagram is constructed from the Lower and Upper 
Quartiles which form the ‘box’, the Median which is 
indicated by a vertical line in the box and end points of 
the whiskers indicate the range of the data. 

The choice is to base it on the groups of the grouped 
data, or (if present) the raw data.

Raw data calculations: 
The LQ is the (n+1)/4th value in ascending order.
The median is the 1(n+1)/2th value in ascending order.
The UQ is the 3(n+1)/4th value in ascending order.

Grouped data calculations: 
the quartile and median are worked out by linear inter-
polation. The resulting boundaries will correspond with 
the results found off the CFD only if the linear drawing 
options has been selected in the CFD dialogue box.
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1D: Dot Plot and Line Plot

 DOT PLOT

 A dot plot can be drawn from any raw data 
set (whether grouped or not). The raw data will be 
displayed according to the settings in the dialogue box:

♦ Horizontal spacing: this effectively groups the raw 
data for the purposes of positioning the dots, e.g. 
setting this = 1 will display discrete integer data.

♦ Vertical spacing: this determines a link with the 
vertical axis so the stacking can be controlled.

 LINE GRAPH -  

    A line graph can be drawn from any discrete 
grouped data set, with or without underlying raw data. 

 Data can be set as ‘discrete’ in the Edit Grouped 
Data dialogue box

Suitable data can also be created with the “Use (x,f) 
Table” option, especially if it exists in column form. 
The option “Integers 1...n” is particularly useful, eg 
for Quarterly data as this creates a set of integers 
for the x values. This is no different from entering the 
frequencies as a comma separated list and using the 
option “Integer Data” for the groupings.

 MOVING AVERAGE

With a Line Graph already in place, a moving average 
can be drawn to a given unit (the default is 4, which 
suits quarterly data). Each of the points making up the 
moving average is placed in the middle of the group 
unlike Excel which places the points at the end of each 
group.

MOVING THE POINTS ABOUT

If you select any single point on the Line Graph, you 
can move it up and down with the UP/DOWN arrow 
keys, and observe the effect on the moving average. 
Use the LEFT/RIGHT arrows to select different points. 
This activity does not alter the data set. 

 The Moving Average ‘Unit’ can be animated.
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1D: Table of Statistics

 TABLE OF STATISTICS

 This Table option is available for any 
grouped data set (whether with underlying raw 
data or not). The information appears in TAB-
separated columns in the Results Box, and the 
class intervals are represented differently for 
continuous and discrete data:

  Continuous data
The class intervals are 0 ≤ x < 20, 20 ≤ x < 40, etc.

  Discrete Data
The class intervals are 0 ≤ x ≤ 19, 20 ≤ x ≤ 39, etc.

 STATISTICS BOX 

     This option is available for all types of 
data, and offers a useful comparison between Raw 
data and Grouped data calculations.

Grouped data calculations are based on the 
mid-interval values. Linear interpolation is used to 
calculate the median and quartiles.

Raw data calculations use an ordered list of the 
actual data.

 STEM AND LEAF DIAGRAM

     For a grouped data set this diagram is 
constructed in the results box. Usual conventions 
are followed: the ‘Stem’ uses the LEFT end values 
of each class interval. The ‘Leaves’ use each data 
value belonging to each stem, and the difference 
between the data value and the stem is given. 

This diagram really only works if the data is 
discrete, and best when the data is integer valued. 
Since it is created in the results box using text, the 
stem and leaf diagram can be selected, copied 
(Ctrl-C) and pasted (Ctrl-V) as required.

If you select information in the 
Results Box, and copy (Ctrl-C), it
pastes elsewhere in “Rich Text”
format, so that font and formatting 
are retained. ‘Arial for Autograph 
Uni’ font is used to ensure that “≤” 
and “∑f”, etc., are used.
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1D: Exporting to ‘Word’

TABLE OF VALUES of 500 from Poisson (3):
Class Int. Mid. Int. (x) Class Width Freq. Cum. Freq.
0 ≤ x ≤ 1 0.5 2 105 105
2 ≤ x ≤ 3 2.5 2 215 320
4 ≤ x ≤ 5 4.5 2 138 458
6 ≤ x ≤ 7 6.5 2 35 493
8 ≤ x ≤ 9 8.5 2 6 499

10 ≤ x ≤ 11 10.5 2 1 500

 ∑f = 500 ∑fx = 1500 ∑fx² = 61987
 Mean = 3 Standard Dev. = 1.84 Variance = 3.37

IN WORD

Use Paste (Ctrl-V).  
This will usually paste the image 
as an “In-line with Text” object. If 
you select it, it will display small 
square ‘handles’. 

IN AUTOGRAPH
 

1. Make the Autograph window about 
the same size as it will appear in Word, 
to minimise any loss of clarity.

2. Use Line Thickness and Draw 
Options, Edit Axes, Text Box, etc. to 
optimise the appearance you want.

3. Use Axes Menu => untick “Show Key”

4. Use Page Menu => “Copy page”.

ADDING A BORDER AND DROP SHADOW

In WORD 2007, the contents of the old ‘drawing 
Toolbar’ are included in the “Insert” thread. First select 
the image, then insert a text box round it. Then select 
the text box object, and use the ‘format text box’ 
thread that appears, to add a shadow.

THE TABLE OF VALUES

Select and copy (Ctrl-V) the table in Autograph (in 
the Results Box). Paste onto the Word page. The 
mathematical symbols used (≤, ∑f, etc.) are in their 
standard Unicode positions, so any font may be used. 
Use Word’s Table options to beautify!
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1D: Sampling and Sample Means

 SAMPLING FROM RAW DATA 

 You can create samples of size ‘n’ from any raw 
data (whether grouped or not). [Advanced Level only.]

A good way to create a large population is in the “Edit 
Raw Data” dialogue box, using the “Sample Data” 
option - there is a maximum of 10000 in any one 
sample.
The first example on the left is a sample of 10000 from 
a continuous pdf.  

SAMPLE DATA

♦ Sample size, ‘n’ (max 10000) 
Enter the desired sample size (minimum n = 1)

♦ Single Sample
Here the individual values of the sample are indicated 
by black arrows on the horizontal axis, together with the 
sample mean.

♦ Clear Sample
Clears all values, leaving the dialogue box open.

♦ Sample
Enter the number of samples (default = 100). This may 
be pressed many times. Each time the values of the 
sample means are displayed in the “Sample Means” 
column, and a dot plot is created on the graph.

SAMPLE MEANS

This column of data can be selected (Ctrl-A), copied 
(Ctrl-C) and pasted elsewhere (Ctrl-V).

EDIT DOT PLOT

You may well need to adjust the x- or y- spacing to suit 
the distribution being created.

INFORMATION

Evidence to support the Central Limit Theorem e.g.:

 Data Set Size, N: 6 [Sample size, n = 50]
 Mean, µ: 3.5
 Std. Deviation, σ/√n:  0.241523

 Sample Means:  500
 Mean, m:  3.47672
 Std. Dev., s:  0.226717

The dialogue box for setting up sample means, 
and thus testing the Central Limit Theorem. 

A single sample of size 5 from a composite continuous 
function, indicated by black arrows, and the mean. 

The parent population was 1000 samples, displayed as 
a Histogram with frequency density unit = 1/1000.

A simple data set of the numbers 1,2,3,4,5,6, and the 
distribution of 500 samples of size n = 5 and n = 50. 



www.autograph-maths.com 33

 Σ

1D: Probability Distributions

At the Advanced Level, the 1D page right-click menu 
includes the option to create probability distributions:

DISCRETE probability distributions
These are plotted in Autograph for integer values of ‘r’, 
usually starting with r = 0, using vertical bars. The sum 
of all the probabilities = 1, and the probabilities in any 
range or cumulative range of ‘r’ can be calculated.

CONTINUOUS probability distributions
These are plotted as a function of x. Probabilities are 
calculated by areas, and the total area = 1. 

 All discrete distributions can generate a table of
 values, which includes cumulative values.

   The animation controller can animate any of 
 the distribution parameters; any dependent 
 objects will alter accordingly.

 Binomial, Poisson and Normal can have their
 parameters chosen automatically to fit data.

  The Mean ± 3SD can be added to any distribution, 
 as small vertical ticks on the ‘x’ (or ‘r’) axis.

 You can use “Autoscale” freely with any of the
 distributions. The first drawn is always rescaled
 and relabelled automatically. 

 You can always edit the axes manually.

,    All the distributions can have their 
thickness and colour altered.

,  can be used to set up appropriate labels.

♦ PROBABILITY CALCULATIONS

 All distributions can have a range probabilities
 calculated.

 Discrete distributions:
 Either enter Lower and Upper limits, 
 or choose to find a cumulative probability.
 
 Continuous distributions:
 These can also have inverse calculations  for 
 one- and two- tailed tests. e.g.:  5% 1-tailed, 
 or 5% 2-tailed (=> 2.5% at each end).
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1D: Discrete Probability Distributions

 The animation controller can be used to 
animate ‘n’ or ‘p’, which will alter the binomial and any 
dependent calculations or objects (Normal or Poisson).

Binomial with n=60, p=0.35 plotted with a cumulative 
calculation, and ‘r’ scale chosen to include all the range 

0-60, and hence the entire distribution. 

TABLE OF STATISTICS
r B(30, 0.35) N(10.5, 6.825)   Poi(10.5)
---------------------------------------------------------------------------------------------------
  1 0.00003942 0.000220865 0.000289133
  2 0.0003078 0.000812938 0.00151795
  3 0.001547 0.00258864 0.00531281
  4 0.005621 0.00713151 0.0139461
  5 0.01574 0.016998 0.0292869
  6 0.03531 0.0350535 0.051252
  7 0.0652 0.0625443 0.0768781
  8 0.1009 0.0965549 0.100902
  9 0.1328 0.128972 0.11772
... ... ... ...

18 0.003056 0.00258864 0.0103508
19 0.001039 0.000812938 0.00572018
---------------------------------------------------------------------------------------------------
 Probabilities < 0.001

B(30,0.35) plotted: Use right-click options to plot its 
dependent Normal (µ = np, σ² = npq) and Poisson 

(λ = npq). Table of Statistics lists all three in columns.

RECTANGULAR (Discrete)

♦ Enter the start and finish 
values of ‘r’ (between 0 and 
10000) to create the uniform 
discrete distribution.

Once entered, you can 
measure probabilities, and 
create a table of values (in 
the Results Box).

A rectangular discrete distribution (six equal 
probabilities of 1/6) with a simple calculation and the 

Table of Statistics displayed in the Results Box.

BINOMIAL DISTRIBUTION

♦ Enter ‘n’ (an integer less 
than 100000) and ‘p’ (0 ≤ p 
≤ 1).

♦ Fit to Data: with data 
entered, you can try to fit 
a Binomial with ‘n’ and ‘p’ 
such that its mean = np and 
variance = npq. If so, the plot 
is scaled up by a factor of ‘n’.

 Using the “Key right” button creates room on the 
right side to display other windows, e.g. the Table of 
Statistics. 

  The Table of Statistics: Columns 3 and 4 are either 
the cumulative values (≤ r and ≥ r), or, when there are 
dependent objects, the equivalent probabilities.
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Here, the distribution has been entered for the throwing 
of 2-dice, and the probability for r > 7 shown, together 
with the Table of Statistics (with cumulative values).

POISSON DISTRIBUTION

♦ Enter the mean (between 
0 and 10000) to create the 
distribution.

♦ Fit to Data: with data 
entered, you can fit a Poisson 
with its mean = data mean, 
and the plot is scaled up by a 
factor of ‘n’.

The Poisson distribution always has “twin towers” when 
its mean is an integer. Here the dependent Normal 

(µ = m, σ² = m) is drawn, and a probability calculated.

 Using the “Text Box” button you can add 
information onto the page from the Status Bar. Status 
Bar text can also be copied in the “Page” menu. 

GEOMETRIC DISTRIBUTION

♦ Enter ‘p’ (0 ≤ p ≤ 1) to create 
the Geometric distribution.

♦ Once entered, you can 
measure probabilities, and 
create a table of values (in the 
Results Box).

The Geometric shows the probability of the number of 
Binomial  events until there is a success. It is therefore 

always a decreasing distribution.

 Using the “Autoscale” button, you can rescale the 
axes automatically at any time - this is often useful if the 
animation controller is in use.

USER DEFINED DISCRETE PDF

 For any discrete pdf enter the probabilities for 
r = 0, 1, 2, etc, separated by ‘,’. A final value is added in 
to ensure that ∑p = 1.
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UNIFORM, Rectangular (Continuous)

1D: Continuous Probability Distributions

The uniform distribution can have any start and finish 
values; here a probability calculation is being carried 

out, and the results displayed in a text box.

µ can take any value and σ can take any value > 0. 
More than one Normal distribution can be displayed 

at a time. Here a two-tailed test is under way.

A combined function. The value of ‘k’ is given in the 
status bar. Here the inverse one-tailed calculation 

(50%) yields the median for this distribution.

NORMAL DISTRIBUTION

USER DEFINED (CONTINUOUS)

♦ Enter the start and finish 
values of ‘x’ (Default is 
-2 to 2) to create a uniform 
distribution with Area = 1.

Once entered, you can 
measure probabilities, which 
are displayed as a shaded 
area under the distribution.

 For all continuous functions, measurement options 
include inverse calculations and one- and two-tailed 
testing.

 The animation controller can be used to animate 
‘µ’ or ‘σ’, and hence to illustrate the transformation from 
N(µ, σ²) to N(0, 1).

 Enter any f(x) and its domain, then optionally 
a second g(x) up to a max value of x. The resulting 
function is scaled by ‘k’ to ensure the area is 1. 

♦ Enter mean and either SD 
or Variance.

♦ Fit to Data: with data 
entered, you can fit the 
normal with the same mean 
and variance as the data, 
and the plot is scaled up by a 
factor of ‘n’.
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1D: Fitting Data

FITTING A BINOMIAL, POISSON or NORMAL

 With a grouped data set plotted as a histogram,
 these three PDFs have a “Fit to Data” option on
 entry (see previous pages). The PDFs use best fit
 parameters, and are scaled up by ‘n’ (Σf). They 
  are dependent objects (will change with the data).

 Double-click on the Histogram to re-edit with
 Frequency Density set with unit = 1. It will shrink
 down to have total area = n, and to fit the PDF.

 Use “Autoscale” as appropriate.

CHI With both Histogram and PDFs now displaying
 frequency, the χ² value is shown in Results Box.

 Setting the Histogram Frequency Density Unit:
 = 1  ensures the total area = ‘n’
 = 1/n ensures the total area = 1    [here n = 100]

Two views of the same data and ‘best fit’ Binomial
A: Histogram set to Frequency Density, Unit = 1
 + Binomial “Fit to Data” ticked in the Binomial entry.
B: Histogram set to Frequency Density, Unit = 1/n
 + Binomial entered: right-click option “Fit to data”.

Here, a sample of 1000 items of data from a 
user-defined PDF (generated in “Edit Raw Data”) 

is compared with the original PDF.

FITTING A HISTOGRAM TO A PDF

FITTING ANY Probability Density Function

 With a grouped data set plotted as a histogram, 
 any  of Autograph’s PDFs can be entered as 
 usual, but  only the three above have the “Fit to 
 Data”  option, when there is no scaling by ‘n’.

 Double-click on the Histogram to re-edit with
 Frequency Density set with unit = 1/n. It will 
 shrink down to have total area = 1, to fit the PDF.

 Use “Autoscale” as appropriate 

 Use probability calculations as appropriate.  

Prussian data: no. of campaigns with 0, 1, 2, 3, 4 
deaths by horse kicks: 109, 65, 22, 3, 1. Binomial 

(large ‘n’,small ‘p’: perfect fit) and Normal (poor fit).

A B
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2D PAGE: XY Graphing
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2D: Standard and Advanced

MAIN
toolbar

2D
toolbar

The 2D page opens 
with the 2D Toolbar

and this standard x-y axes

THE 2D PAGE: 
The TOP LEVEL 

RIGHT CLICK MENU

♦  Enter Equation [Pressing ENTER also opens this]
 The type of equation is detected automatically. Constants can be
 included; Start-up options will depend on the type of equation.
♦  Enter XY Data Set
 Enter or paste bivariate data. Axes can be swapped; data scaled.
♦ Enter Co-ordinates
 You can use numbers, expressions or constants. 
♦ Enter Vector Line [Advanced Level only]
 A line in the form:    [x,y] = [a, b] + λ[c, d]
♦ Enter Shape:  
 A choice of ‘preset’ shapes, or enter a set of coordinates.
♦ Text Box: Place a text box on the graphing area.
 

♦ Insert Image: Place an image file on the graph page

The equation key is present by default,
but can be turned off/on using the 

tick in the Axes Menu
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2D: Graphing Toolbar

USEFUL TOOLS from the MAIN toolbar

  Key below and key right: to control layout

   Degrees/Radians [Advanced Level only]

  Constant controller; Animation controller

THE 2D GRAPHING PAGE TOOLBAR

AXES RELATED CONTROLS

  Reset axes: y-x The default XY setting

  Reset axes: x-t This is useful when ‘t’ is the 
 independent variable (e.g. differential equations)

 Reset axes: x This allows work on the number
 line, with no ‘y’ axis

These options all re-start the page as they are 
likely to imply a change of variables. To avoid a 
reset use Edit Axes (“Labels” and “Options”).

 

 Default axes. This intelligently offers axes
  ranges appropriate to what is plotted: eg

  y = sinx (degrees) x: –90° to 360°, pips 45°
  y = sinx (radians) x: –�/2 to 2�, pips �/4
  y = sin–1x (radians) y: –�/2 to 2�, pips �/4
and an XY data set has all points showing.

 Cartesian grid The default

 Polar grid [Advanced Level only]

 No axes Ideal for some geometrical work

 Equal Aspect - alters the x-scale so that the
 axes are square. Stays in force for the current 
 page, whatever happens to the window, but is
 cancelled by any zoom action that contradicts it.
____________________________________________

ADDING NEW TOP LEVEL OBJECTS

 Add XY Data set 
 Add Equation  
 Add Vector Equation, Straight Line
 Add Shape 
 Add coordinates

PLOTTING CONTROLS for classroom use
(*) These refer to the current equation (as indicated in 
the key), so you can pause one, restart another, etc.
 

 Replot (*) - this will open the Start up Options 
 (and option to change them) then replot.

 Pause/restart (*) - in slow plot mode this 
 controls the current equation (also SPACEBAR).

 Fast Forward/complete (*) - in slow plot mode
 this will finish off the current equation. 

 Plot mode slow/fast. This stays on all the time,
 even with a new page. Strongly recommended.
____________________________________________

CREATING RELATED GRAPHS
based on the current equation (as indicated in the key)

 Create Gradient Function [Advanced only]
 Drawn as a dotted line. When “Slow Plot” is on, 
 this is an animation with a moving tangent,
 pausing at each max/min/point of inflexion.

 Create Integral Function [Advanced only]
 This uses the same routines as 1st Order 
 Differential Equations; requires a starting point.
 

 Create Reflection in y=x
 Draws y=x, and the function with ‘x’ and ‘y’ 
 swapped over.
____________________________________________

 Manage Equations
 A look at the equation list, to copy/paste and turn
 off/on the list.

 Define f(x) and g(x)
 f(x) definitions can include g(x) and constants.

 History - in the main toolbar, but useful here, 
 for replotting previous equations.

THE PAGE MENU

Use “Page” => “Edit Settings” to set the page name, 
angle measure and precision (sig. fig.) for the page. 
To set the precision permanently, use “View” => 
“Preferences”. In the Advanced level, all new pages 
open in Radian measure.
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2D: How to Enter and Edit Free Points

HOW TO ENTER FREE POINTS

 Points can be ‘free’, or ‘attached’ to another object (e.g. a straight line or a graph), or can be grouped to form a
 SHAPE or an XY DATA SET. You can add points using the ‘point mode’ in the MODES toolbar. The last point is
 always left selected as the ‘current’ point and its coordinates are displayed in the Status Bar to the current
 decimal place setting (default: 4).  If you hold SHIFT, all the points are selected as you click to add them.

 The Standard level offers these buttons; the default ‘Snap’ setting = 1 for easy adding of integer points. 

 You can switch to a step of 0.1 using the other button, which is the default setting in the Advanced Level.

 Alternatively, you can use this right-click option to “Enter Coordinates”.  
 Coordinates can contain EXPRESSIONS,  e.g. (π/3, 0), 
 or CONSTANTS, e.g. (a, b) which can subsequently be varied dynamically by the constant controller. 
 

 If you hold SHIFT as you place points, all the points are placed as selected points.

HOW TO SELECT POINTS

 Select Mode: To ensure you are in Select Mode, either click the select button, or press  ‘ESC’. 
 Pressing ESC for the second time will also ensure that all previous selections are cancelled.
 This is very important if you are in “No-Shift for multiple select” mode.  Click on one or more points to select.

 ○ There are THREE states for points in Autograph, whether they are ‘free’ or attached   
 to curves:  1 - UNSELECTED,  2 - SELECTED, and 3 - the last to be selected and 
 therefore the CURRENT point, whose coordinates are given in the Status Bar.

 ○ You can move which is the ‘current’ point round the point set by pressing TAB.

 ○ MARQUEE SELECT: In select mode, you can select points by dragging a rectangle round them with the mouse.

 ○ Selected points can be deleted (press “Delete”). The next recent point then becomes the ‘current point’, so all
 points can be deleted one at a time by pressing “Delete”.

 ○ TRACE: With one or more points selected, the right-click option “Trace” will create a trace of the point(s) 
 if any other action causes them to move.

HOW TO MOVE POINTS

 A selected point can be moved about by dragging with the mouse, 
 or by using the ARROW keys as follows:
 LEFT-RIGHT will move it in the ‘x’ direction, UP-DOWN in the ‘y’.

 The default step is x 0.1, but holding CTRL: x 0.01; SHIFT AND CTRL: x 0.001.
 Holding just SHIFT: x 10. All these steps are relative to the axes grid.

  In the Standard Level, the 2D page starts with the ‘Snap’ set to 1, so all the above steps are multiplied by 10.

HOW TO EDIT POINTS
 ○ TO EDIT A POINT: (as with all other objects in Autograph), double-click on it. Both coordinates can be edited.

1 2
,3
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2D: Other Uses for Points

POINTS CAN MAKE A SHAPE

  A selection of points can be made into a SHAPE using the right-
click option “Group to Shape”.

To select the shape, click on its shaded area. A selected shape can 
be dragged about or moved using the ARROW KEYS (with Ctrl, Shift. 
etc, as with a single point).

A single point in a shape can be selected and dragged about with the 
mouse, or moved with the ARROW KEYS.

POINTS CAN MAKE AN XY DATA SET

 A selection of points can be made into an XY DATA SET using 
the right-click option “Create Data Set”.
To select an XY data set, click on any one of its points. To select an 
individual point in the dataset, use CTRL-click. With Ctrl, you can drag 
this point, or delete it.  

You can use MARQUEE select to make a selection of several points 
in the data set. Use the right-click option on a selected dataset 
“Revert to points”.

POINTS CAN BE ATTACHED TO OBJECTS

 To attach a point to an object, in ‘Point’ mode, the mouse cursor 
will change to a small black arrow when you are over an object, 
such as a graph, straight line, circle, etc. This indicates that a left 
mouse-click will place and attach a point on the object.  
[This is hard to do on a Smart Board as there is no ‘mouse’ signal].

With many objects, e.g. a y=f(x) graph, you can also select the object 
and use the right-click option “Enter point on Curve”. You enter just 
one coordinate.  This is usually ‘x’, but in the case of x = f(y) it is ‘y’, or 
a polar graph r = f(θ) it is ‘θ’. 

With an attached point selected, you can move the point along the 
object by dragging with the mouse, or using the LEFT-RIGHT arrow 
keys.

If there are two or more y = f(x) objects present, and a point attached 
to one, use the UP/DOWN arrow keys to move the point between 
the objects, with the same value of ‘x’.

With a free point and an object selected, use the right-click option 
“Attach to object” to move the point onto the object (same value of 
‘x’).

Points can be attached to all objects, 
including graphs, lines, circles, etc
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2D: The Straight Line

THE STRAIGHT LINE

The straight line is an important object in Autograph, used for 
reflection and various intersections. For each, the equation is given 
in the Status Bar in the form y = ax + b,  or x = k. There are several 
ways to create lines, by these selections and using the stated Right-
click option:

ONE POINT selected:
♦ Horizontal Line     y = a
♦ Vertical Line      x = b
♦ Straight Line [enter gradient, m]    y = mx + c

ONE POINT selected ON A GRAPH :
♦ Tangent 
♦ Normal 

TWO POINTS selected:
♦ Straight Line  Equation given
♦ Line Segment Length AB given
♦ Perpendicular Bisector Equation given
♦ Gradient (right-angled triangle) ∆y, ∆x; equation of line; ∆y/∆x

ONE POINT and a STRAIGHT LINE selected: 
♦ Parallel Line  Equation given
♦ Perpendicular Line Equation given

TWO LINES or LINE SEGMENTS selected:
♦ Angle between the lines Degrees or radians (Results Box)
♦ Intersection point Coordinates given (Results Box)

THREE POINTS selected (one is the ‘current point’):
♦ Angle bisector (at current point) Equation given

y=f(x) GRAPH selected
♦ Asymptote  Tangent at x = ∞

XY DATA SET selected
♦ Line of best fit [Standard Level] 
♦ y-on-x regression line; x-on-y regression line [Advanced Level]
______________________________________________________

Also, you can ENTER the STRAIGHT LINE’S EQUATION:  

♦ y = f(x) form:  y = mx + c
♦ x = f(y) form:  x = k  or  x = my + c
♦ Implicit form:     ax + by = c       x/a + y/b = 1
  (y – b)/k = (x – a)/h
♦ Vector form: [Advanced Level] [x, y] = [a, b] + λ[h, k]

Perpendicular bisector

Gradient triangle and Status Bar 
information (in the Status Box)

3 points leading to a circle, a triangle, 
a perpendicular bisector (green) 

and an angle bisector (red)
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2D: Circles and Conics

All Cartesians conics constructed in Autograph are rearranged 
internally as y = ... ± √... , which have two branches. A point added 
can move round one branch (LEFT/RIGHT arrows), or can swap 
branches (UP/DOWN). Double-click to edit the point’s ‘x’ coordinate.

THE CIRCLE
There are two distinct types of circles in Autograph, and for each form, 
the equation is given in the Status Bar as (x – a)2 + (y – b)2 = r2. 

CARTESIAN CIRCLES

THREE POINTS selected
♦ Circle

PARAMETRIC CIRCLES
A point added can be dragged right round the circle (LEFT/RIGHT 
arrows). Double-click to edit the point’s parameter value and its ‘t’ 
snap.

ONE POINT selected
♦ Circle [enter radius] 

TWO POINTS selected (one is the ‘current point’)
♦ Circle Centre at the current point

ONE POINT and a LINE SEGMENT selected
♦ Circle by centre and radius
_______________________________________________________

OTHER CONICS
The equations of all other constructed conics in Autograph are given 
in the form ax²  + by² + cxy + dx + ey + 1 = 0.

THREE POINTS selected (one is the ‘current point’)
♦ Ellipse (two foci, and the current point on the perimeter)

A POINT and a STRAIGHT LINE selected 
♦ Conic (enter eccentricity) 

FIVE POINTS selected
♦ Conic
_______________________________________________________

Also, you can ENTER the CONIC’S EQUATION   
♦ Cartesian:  x²/a² + y²/b² = 1 (x – a)² + (y – b)² = r²
 General conic:  ax² + 2hxy + by² + 2gx + 2fy + c = 0
 

♦ Polar:  r = k 1/r = 1 + kcosθ   [k = 0, ½, 1, √2, 2]
 

♦ Parametric:   x = at², y = 2at    x = asinθ, y = bcosθ

Examples of a dynamic construction 
involving points, lines and circles

A conic constructed from 5 points. 
Each branch was selected separately

and an asymptote drawn

A circle from two points, and a tangent
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2D: Calculations

CALCULATED POINTS

Autograph uses “Points” (those entered by the user), and 
“Calculated Points” - these are not added to the set of points, and 
are indicated by a small coloured square.  They can be selected (for 
deletion), and a point can be attached to a calculated point.

TWO POINTS selected AB (where ‘A’ is the ‘current’ point)
♦ Midpoint  Coordinates (a, b) given
♦ Ratio: calculated point ‘P’ Enter the ratio AP/AB

THREE POINTS selected 
♦ Centre of circle Coordinates (a, b) given

THREE or MORE POINTS, or an XY DATA SET selected
♦ Centroid Coordinates (, ) given

POINT ‘P’ and a CIRCLE (centre O, radius r) selected
♦ Inversion point P’ OP x OP’ = r²

TWO OBJECTS selected (e.g. 2 lines, 2 graphs, line and circle, etc)
♦ Intersections List of points in the Results Box
Alternatively, in POINT mode, hold CTRL and wait for the mouse 
cursor to change to a circle to place a point AT an individual 
intersection.

A POINT and a STRAIGHT LINE selected
♦ Closest point on the line Point marked; distance given
To place a point here, use point mode and click on the line.
______________________________________________________

CALCULATED BEST FIT CURVES

TWO POINTS selected (one is the ‘current point’)
♦ Quadratic (enter gradient) y = ax² + bx + c 

THREE POINTS selected (one is the ‘current point’)
♦ Quadratic graph Equation: y = ax² + bx + c
♦ Cubic graph (enter gradient) Equation: y = ax³ + bx² + cx + d

FOUR POINTS selected
♦ Cubic Graph Equation: y = ax³ + bx² + cx + d

‘n’ POINTS or a DATA SET selected
♦ Best Fit polynomial up to degree 6
An exact polynomial of degree (n – 1) is given when only n points 
are selected up to n = 7.  Otherwise a ‘best fit’ polynomial is given, 
just enter n (from 2 to 6). The method of least squares is used to 
derive it.Quartic and cubic best fit from 5 points

The equation of this quadratic in the Status 
Box (double-click on the Status Bar)

Examples of calculated points, 
and a shortest distance.
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2D: Vectors

VECTOR CREATED FROM A SINGLE POINT
A vector must have a point to ‘sit’ on, so to create a vector you must 
have a point selected.  Use the right-click option “Vector” and enter 
the coordinates, either Cartesian [x, y] or polar [r, θ]. If constants are 
used here, these can be altered using the Constant Controller.  

The vector can then be moved by dragging the base point. 

VECTOR CREATED FROM TWO POINTS
Alternatively, a vector can be created between two selected points, 
making it moveable at either end.

 A vector consists of three objects: base point, end point and stem 
(with an arrow at the mid-point).  To select a vector click on its stem.
_______________________________________________________

ONE VECTOR [a, b] and a POINT [h, k] selected, 
a new vector can be created based on the point as follows:

♦ Perpendicular vector [–b, a]
♦ Negative vector [–a, –b]
♦ Copy vector [a, b]
♦ Unit vector [a/r, b/r],   r = √(a² + b²)
♦ Multiply vector (enter factor) [ka, kb]
This creates a scalar multiple of the original vector. ‘k’ can be 
animated.

♦ Line from vector (*) [x, y] = [h, k] + λ[a, b]
♦ Parallel line (*) y = mx + c
♦ Perpendicular line (*) y = mx + c
(*) These are all drawn through the selected point [h, k]

♦ Closest point, and distance  on the line of the vector 

TWO VECTORS [a, b] and [c, d] selected, 
♦ Angle between two vectors (*) in degrees or radians 
♦ Scalar (or Dot) Product (*) ac + bd
(*) given in the Results Box 
 
TWO VECTORS [a, b] and [c, d] and a POINT [h, k] selected, 
a new vector can be created based on the point as follows:

♦ Add vectors [a + c, b + d]
♦ Subtract vectors [a – c, b – d]
_______________________________________________________

 VECTOR EQUATION of a STRAIGHT LINE [Advanced level]

This can be added any time as it is a top level right-click option, 
using the form: [x, y] = [h, k] + λ[a, b] You can use constants in 
any of the coordinates.

Two ways to enter a vector

Elementary vector algebra

Vectors and lines in 2D

The vector equation of a straight line, and a 
parallel vector, both using constants.
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 In the right-click menu (or the ‘Object’ menu) use 
Insert Image ... 
 

This opens a standard file window, and you can select 
files of all the popular types:
▪ emf [enhanced metafile], wmf [windows metafile],
 jpg, png, bmp, gif or tif

Initially the image is placed centrally and scaled to fit 
easily on the page. The image is an Autograph object. 

▪ Click on it once to select it (for deletion or to drag it) 
▪ Any of its 8 tags can be used to resize it dynamically. 
▪ Dragging a corner will preserve the aspect
 
▪ Double-click on the image to edit its properties: 
 Brightness, Contrast and Transparency - the effect
   is previewed instantly. These may need adjusting 
 when it its planned to draw graphs over the image. 
 

 Press “OK” to confirm, or 
 press “Cancel” to return to the previous settings.

2D: Adding an Image

Angles can be measured:

(a) defined by three selected points
 The angle is displayed at the middle point
(b)  defined by two selected lines
 The angle is displayed at the intersection of the two
 lines
(c)  Angle defined by two selected vectors
 The angle is displayed at the intersection of the two 
 vectors 

The angle ‘object’ is a filled circular arc.
If the angle is 90°, the usual rectangular symbol is used. 

The appearance of the angle object can be altered 
using Edit Draw Options or by using the buttons on the 
main toolbar. 

SETTINGS

Allow Reflex Angle - will show angles greater than 180°, 
measured anticlockwise from the first two points. 
Angle Arc Size - stated in a nominal mm measurement.

 Scale Image with Axes:
 Tick this to ensure that the image is locked to the axes 
 and will scale with any zooms, etc. Otherwise it will 
 stay its original size on the screen

2D: Measuring an Angle

LABEL

Show Label - this will give the value of the angle
Edit Label Settings - this opens the dialogue box for a 
Dynamic Text Box, where you can set the appearance 
of the text, and whether it anchors to the angle object. 

An example of a paper folding exercise simulated
in Autograph, with key angles measured

A stop-frame image of a bouncing ball,
fitting a parabolic path



www.autograph-maths.com 49

2D

NOTES



www.autograph-maths.com50

  2D

2D: Transformation of Shapes

SHAPE

CREATING AND EDITING SHAPES

  Shapes are created in Autograph by selecting a number 
of points and using the right-click option “Group to shape”.  
Alternatively, use the “Add Shape” button to enter the coordinates, 
or use a pre-set shape (flag, unit square, rectangle). The default 
option is to fill the shape.

To select a shape, click on the shaded part. You can alter its ap-
pearance using the right-click option “Edit Draw Options”.

You can drag a shape about (dragging the shaded part), or you can 
drag any one of its points separately. To edit a shape, double-click 
on it.  A selected shape can also be moved using the Arrow Keys.
______________________________________________________

CREATING DEPENDENT SHAPES

With a SHAPE selected, you can create a new, dependent shape:

♦ a Reflection in the x- or the y-axis
♦ a Shear in the x- or the y-axis (enter the shear factor) 
♦ a Stretch in the x- or the y-axis (enter the stretch factor)
♦ a Transformation by entering a 2x2 matrix [Advanced level only]

With a SHAPE and a POINT selected, you can create a new shape:

♦ an Enlargement (enter the initial factor)
♦ a Rotation (enter the initial angle)

With a SHAPE and any STRAIGHT LINE (constructed or by an 
equation) selected, you can create a new, dependent shape:

♦ a Reflection

With a SHAPE and any VECTOR selected, you can create a 
second, dependent shape:

♦ Translation

If the vector is based on two points, you can animate this translation 
by moving the end point of the vector.
______________________________________________________

Animating a dependent transformed shape

 To animate a shear, stretch, enlargement or rotation, select the 
new shape and use the animation controller to vary the factor or 
angle dynamically, or to set up an automatic animation.

A shape formed form a set of points

Select a shape and a line for Reflection

Select a shape and a point for Enlargement

Select a shape and a point for Rotation
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2D: Matrix Transformations

First create and select a shape, and use the right-click option 
“Matrix Transformation” [Advanced level only].

To enter a User Defined matrix, enter each element, followed 
by TAB, noting that the order is by columns, to emphasize the 
transformation of the unit square defined by (1, 0) and (0, 1). 
The elements can include expressions (e.g. √3/2), or constants. 
Alternatively you can use one of the Presets (listed below).

Show Eigenvectors: this option will draw the two eigenvectors as 
dotted lines (if they exist) and state their equations.

Inverse Matrix: this replaces the entered matrix with its inverse.

PRE-SETS: 2 x 2 Matrices listed here by columns 

Enlargement  (  k   0   0   k ) Δ =   k2

Reflection, x = 0 (–1   0   0   1 ) Δ = –1
Reflection, y = 0 (  1   0   0 –1 ) Δ = –1
Reflection, y = x (  0   1   1   0 ) Δ = –1
Reflection, y = –x (  0 –1 –1   0 ) Δ = –1 

Reflection, θ (  cos2θ   sin2θ   sin2θ –cos2θ ) Δ = –1
Rotation, θ  (  cosθ   sinθ –sinθ   cosθ ) Δ =   1

Rotation, –90°  (  0 –1   1   0 ) Δ =   1
Rotation, 30°   (  √3/2   1/2 –1/2   √3/2 ) Δ =   1
Rotation, 90°  (  0   1 –1   0 ) Δ =   1
Rotation, 180°  (–1   0   0 –1 ) Δ =   1

Stretch  (  a    0    0    b ) Δ = ab
Shear // x-axis (  1    0    k    1 ) Δ =   1
Shear // y-axis  (  1    k    0    1 ) Δ =   1
Singular  (  a    b    ka    kb ) Δ =   0

A = (a, b, c, d) Determinant: Δ = ad – bc. 
Eigenvalues: λ = two roots of  k² – (a+d)k + Δ = 0
Eigenvectors, the two equations: y = (b/(λ – d))x     [λ ≠ d]

 The Animate option

If the elements include one or 
more constants, use this option to 
animate their values and display 
the matrix.

If the elements do NOT include 
any constants, use this option to 
repeat the transformation, i.e. An 
for n = 2, 3, 4 or backwards to 1, 
0, –1, etc. 
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2D: XY (Bivariate) Data

In Autograph, an XY data set is a single object made up from a 
number of points. You can have several data sets on the same 
page, and each has a different colour. 

  “ENTER XY Data Set”

This dialogue box offers three basic ways to create a data set:

  PASTING IN FROM A SPREADSHEET
First select two columns of data (e.g. columns ‘D’ and ‘F’ in the 
illustration). If the two columns are not adjacent use CTRL as 
you select the second column. Unfortunately, any intermediate 
columns are also put on the clipboard. To get around this, paste 
the selection into a new spreadsheet page, select and copy again.

Back in Autograph, in the Edit Data Set dialogue box, click on 
the top left empty cell and paste in the data (CTRL-V, or use 
the right-click “paste” option). The column headers are entered 
automatically. To edit them, click on a cell in one column and use 
the right-click option. 

 ○ MANUAL ENTRY
Enter the points manually: click on the first cell, enter the first 
item, then press ENTER then the next, then press ENTER, etc. 

 IMPORT (CSV):
Use this option to import data that has been saved as 2-column 
CSV file (comma-separated variable). Likewise to Export.

____________________________________________________

♦ Scale Options: Use this to apply a formula to either column. 
‘x’ refers to the left column, ‘y’ to the right.

♦ Column Headers: To use either or both headers as the axes 
lables, tick the options.

♦ Memory: Use this to store a data set, e.g. if you want to scale it 
and then return to the original values (using “Recall”).

♦ Sorting: use these options to sort either column.

♦ Swap: use this to swap the axes if the wrong one is the 
independent variable (as here).

♦ Show Statistics: tick this to add a statistics results box (see 
opposite). More detail is given at Advanced level.

♦ Join Points: Use this option to join up points. Only suitable for 
‘sequential’ data. 

♦ Perform Autoscale: this ensures that all the data appears on 
the graph axes when plotted (ticked by default).Any empty or invalid data cells are ignored.
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2D: XY Scatter Diagram

THE DATA SET OBJECT (Scatter Diagram)

On exiting “Edit Data Set”, the points are plotted automatically 
as a data set object (Scatter Diagram) with a new colour. With 
“Perform Autoscale” ticked in the dialogue box, the data will all 
appear on the page. If not, you may need “Default Scales” for the 
data to appear.  

♦ To select or edit the data set: Click on any one point to select 
all the points as a single object. Double-click on any one point to 
return to the “Edit Data Set” dialogue box. At this point, data can 
be added, deleted, scaled, etc.

♦ To select individual points: use CTRL and click, or use the 
rectangular marquee selection (when in ‘select’ mode). 

With a DATA SET selected a number of options are available:
♦ Centroid: shows (, ) as a calculated point (small square).
♦ Line of best fit [Standard Level] 
♦ y-on-x or x-on-y regression line [Advanced Level]

♦ Transformation - by the standard set of transformations: 
Reflection, shear and stretch in x- and y-axes; Matrix 
[Advanced Level]. In each case, a new, grey, dataset is shown. 
Also: Reflection (with a selected line),  Translation (with a 
selected vector); Rotation, Enlargement (with a selected point).

With a DATA SET and ANY STRAIGHT LINE selected:  
♦ x-on-y residuals; y-on-x residuals (Advanced Level). 
Options: lines or squares; ensure square aspect; ∑r² given.

With a DATA SET and ANY y = f(x) graph with constants: 
♦ Best fit to Data 
This will find (by least squares) the best value of the constants to 
fit the data, e.g. y = asin(bx + c) + d.  Select the graph and use 
the option “Update Results Box” to obtain a list of the constants. 
If a polynomial fit is required (up to x6), select the data set and 
use the option “Best Fit ..”
____________________________________________________

Other ways to CREATE/EXTEND A DATA SET

 Select a number of points, and use the option “Convert to 
Data Set”. You can also select some free points AND a data 
set, and use the option “Add to Data Set”.  “Revert to points” 
reverses this.

 Select a y = f(x) graph, and use the right-click option 
“Create Data Set”. This is the best way to perform a geometric 
transformation on a plotted graph. 

A linear data set derived from 2 columns in 
Excel, with Regression line and text box.

Using the “Best Fit to Data” option: in this case 
best values of ‘a’ and ‘b’ were found.

Tick “Show Statistics” in the “Edit Data Set” 
dialogue box, to obtain this information.
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2D: Entering Equations

 Click this button, or press ENTER any 
time, or use the right-click “Enter Equation” 
to bring up this dialogue box.

Equations are entered as text, so can be 
pasted in from elsewhere.

Mathematical symbols come from the 
Arial for Autograph Uni font. Either use 
the buttons provided, or use the ALT key 
shortcuts below, which will work in all of 
Autograph’s dialogue boxes.

Alternatively, you can use the on-screen 
keyboard.

DIRECT ENTRY OF MATHEMATICAL SYMBOLS
“xx” enters x2, “xxx” enters x3, etc., up to x6. The following keyboard shortcuts can be used to enter spe-
cial characters at any input box in Autograph: hold down ALT and tap the other: 

   

         

     

Notes: For all other indices, use ^ (SHIFT-6), e.g. y = e^sinx
 Greek letters can be ‘constants’ in equations, apart from θ (which is reserved as a parameter).

The following mathematical operators are used in Autograph:
 sin cos tan cosec sec cot 
 sin-1  cos-1  tan-1  cosec-1  sec-1  cot-1  [or arcsin, etc]
 sinh cosh tanh cosech sech coth
 sinh-1 cosh-1 tanh-1 cosech-1  sech-1 coth-1  [or arcsinh, etc]
 log  ln  e Brackets are optional, e.g. y = 2sin22x or y = 2sin2(2x)

 

EDIT CONSTANTS  
 

Click here to set the initial values of any constants in the equation, if necessary. They are all pre-set to 
start =1. Once the graph is drawn, the Constant Controller can vary the constants dynamically.

 ALT  1 2  3 4  5  6  x y n
Indices x-1  x2  x3  x4  x5  x6  ex ey xn

ALT A B E F L M P S T
Greek α β ε φ λ μ π σ θ

ALT R + I H < > ‘PI’ also enters π

Maths Ä ± | ½ ≤ ≥ <= and >= enter  ≤ and ≥
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2D: Cartesian Equation Types

STARTUP OPTIONS and DRAW OPTIONS
There are various equation types that Autograph understands, and 
each have their own startup options (see below). With the Draw 
Options you can vary colour, thickness and line style (eg dashed).
_______________________________________________________

y = f(x), or equations that simplify to y = f(x)

♦ Straight lines: y = mx + c  ax + by = c

♦ y = f(x):  y = x2(x – a)  y = asin(bx)

♦ Inequalities: 2x + 3y ≤ –2  y < sinx
‘≤’ or ‘≥’ draws with a solid line; ‘<’ or ‘>’ draws with a dotted line
The default is to shade the ‘reject’ region, but this can be set to the 
‘accept’ region in “View” => “Preferences”.

♦ 2nd degree: y2 = x(3 – 2x)  x2 = y2

  (x – a)2 + (y – b)2 = r2 x2/a2 – y2/b2 = 1
  ax2 + by2 – 2gx – 2fy + hxy + 1 = 0
These are all arranged internally as y = ±Ä(... ) and plot as two sepa-
rate functions, each of which can be selected separately.

STARTUP OPTIONS: For all of the above, the default is to plot with 
automatic step from x-min to x-max. You can switch this to ‘manual’ 
and control the domain, e.g. to plot just a segment of a graph. 

The General Implicit 
♦ f(x, y)  sinx = cosy 
These are generated by a special process, and the resulting plots are 
not ‘functions’, so cannot be selected, or have points placed on them.

STARTUP OPTIONS: you can set the  intensity of the scanning from 
1 to 200 in either, or both, directions. The default is 100.

Piecewise Expressions
♦ y = ..., ..., ... y = sinx, cosx, 2 – x
Enter several functions, each separated by a comma. 
STARTUP OPTIONS: You set the start ‘x’ value for each function, and 
the final end value.  The resulting function plots as if it was a single 
graph, and can be treated as such (e.g. gradient, intersections, etc).
_______________________________________________________

x = f(y), or equations that simplify to x = f(y)

eg  x = 2   x = ln(y)
  x2 = y2   x3 = siny
’y’ becomes the independent variable.

Inequalities

2nd degree equations (conics)

Piecewise function

Inverse trig function
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2D: Objects Related to Graphs

WITH A GRAPH SELECTED you can: 

♦ Update Results Box: This places the equation and the values of 
any constants in the Results Box.

♦ Table of Values: enter range and step, and the table is created as 2 
TAB-separated columns of text, which can be copied out to Excel.

♦ Create a Data Set: enter range and step, and this places a data 
set of joined up points on the graph. If selected, this data can be 
transformed just like a shape: translation, reflection, shear, rotation, 
matrix, etc.

♦ Draw the Evolute: enter range and step to draw a family of tan-
gents or of normals to the selected curve.

♦ Asymptote: draws a tangent at a very large value of ‘x’.

♦ Solve f(x) = 0: this places a (purple) marker point on all the 
solutions in the plotted range, and puts a list in the Results Box.

♦ Solve f’(x) = 0: this places a (purple) marker point on all the turning 
points in the plotted range, and puts a list of the answers in the Re-
sults Box. You can add a point to any such marker point if required.

♦ Enter point on curve: enter ‘x’ coordinate [or ‘y’ for x = f(y) graph]. 
_______________________________________________________

WITH ONE POINT ON THE GRAPH
All the coordinate geometry options for a single point (e.g. vertical, 
line, vector, etc.) together with:
♦ Tangent Equation given as y = mx + c
♦ Normal Equation given as y = mx + c 

♦ Move to next f(x) = 0 Moves to the right
♦ Move to next f’(x) = 0 Moves to the right 

♦ Attach to object: available if you select a point NOT on a graph. 
The point takes its value of ‘x’ to the graph and becomes attached.
_______________________________________________________

WITH TWO POINTS ON THE GRAPH
♦ Gradient (right angled triangle) ∆y, ∆x; equation of line; ∆y/∆x
_______________________________________________________

WITH TWO GRAPHS SELECTED
♦ Solve f(x) = g(x): “Calculated points” (small coloured square) are 
placed at all intersections. A list of the coordinates is posted in the 
Results Box. You can add a point to any of these if required.

  CTRL with the Point Mode  
While holding CTRL, wait for the mouse cursor to change to a circle 
over an intersection or max/min, then click to place a point there.Two points on y = x²: gradient triangle

Coordinate geometry

Function as a data set, then rotated

Table of values (in the results box)
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2D: Creating Related Graphs

THREE ‘CREATE’ OPTIONS  
for the currently selected y = f(x) Graph 
as listed in “Equation” => “Create”
 

 1. REFLECTION in y = x

This will draw y = x as a dotted line together with the reflection of the 
current graph. Its new equation is given in the status bar, obtained by 
swapping ‘x’ and ‘y’ in the current equation. The resulting graph may 
or may not be an ‘inverse’ function.

_______________________________________________________

 2. GRADIENT (Slope) Function  [Advanced Level only]

This will create the first derivative of the currently selected equation, 
plotted as a dotted line.

 If Slow plot is ON, the gradient plots slowly, showing a moving 
tangent on the parent graph. Plotting pauses at all turning points on 
the way. Press the spacebar to continue or pause at will.

_______________________________________________________

 3. INTEGRAL FUNCTION  [Advanced Level only]

By default, this waits for mouse clicks to set the initial value (xo, yo) for 
each solution. e.g. y = x2 will give solutions of the form y = ⅓x3 + c.  

This is effectively solving the 1st order differential equation dy/dx = x2, 
and the start-up options for an integral function are the same as those 
for a 1st order Differential Equation (see page 62). With Slow Plot on, 
the solutions are generated slowly. 

_______________________________________________________

 DEFINING FUNCTIONS f(x) and g(x)
Use this option to enter an expression in ‘x’ for f(x) and or g(x). 
Either can also include a reference to the other, for example: 

Definition: Equation entry:
  f(x) = x2 y = f(x)  
 y = f(x + a)
  g(x) = (f(x + h) – f(x – h))/(2h) y = g(x)

Reflection in y = x

1st Derivative created by the tangent slope

Integral function

Use of function definitions
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2D: Numerical Methods 1 - Areas

 AREA between a graph and the axis.

This right-click option is available on the selection of
♦ y = f(x) graph, OR   two points ON a y = f(x) graph,

OR
♦ x = f(y) graph, OR   two points ON a x = f(y) graph.

The dialogue box offers four options, using start and end values of 
‘x’ (or ‘y’) that are entered, or taken from the two selected points.

“Show Centroid” will mark (, ) as a “calculated” point.

Rectangle (–): 
The first rectangle 
takes the height of
the first ordinate

Rectangle (+): 
The first rectangle 
takes the height of 
the second ordinate

Trapezium 
Rule: uses 
trapezium 
elements Simpson’s 

Rule: uses
quadratic 
elements

An area defined by two POINTS can be varied by moving either point.
  
To select an area, click on one of its vertical lines
To re-edit an area, double-click on one of its vertical lines

 With an area selected, the ANIMATE button allows the number of 
divisions to be animated.
_______________________________________________________

 AREA between two graphs

EITHER: select two y = f(x), or x = f(y) graphs (order is significant), 
and use the right-click option to enter the start and finish values.

OR: select a point ON the first graph, and then a point on the second 
graph (the order is significant), then use the right-click option.

The two points must be associated with each of the graphs, so to 
use the intersection points, put the points on to the LEFT of each 
intersection. Then for each, select one point and the OTHER graph, 
and use the option “move to next intersection”.

An area with the number of divisions 
increased using the Animation tool, 

and the graph zoomed in.

An area between two graphs, 
with the number of divisions increased,

and the graph zoomed in.
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2D: Numerical Methods 2

♦ NEWTON-RAPHSON ITERATION 
 
EITHER select a y = f(x) graph:
The right-click option opens a dialogue box which controls the 
iterations. The initial value xo is entered. Use the arrow buttons or use 
the UP/DOWN arrow keys to add or subtract iterations.

OR select a point ON a y = f(x) graph
Create iterations as above. You can then move the point about to vary 
the iteration.

To select an iteration: click on any of its elements.
To re-edit an iteration: double-click on any of its elements.
_______________________________________________________

♦ BISECTION ITERATION 

EITHER select a y = f(x) graph, 
The right-click dialogue box controls the iterations. The initial values 
xo and x1 are entered. Use the arrow buttons or use the UP/DOWN 
arrow keys to add or subtract iterations.

OR select TWO points ON a y = f(x) graph.
_______________________________________________________

♦ FIXED POINT ITERATION: x = g(x)

EITHER select the graph y = x AND a y = f(x) graph

The right-click dialogue box controls the iterations. The initial value xo 
is entered. Use the arrow buttons or use the UP/DOWN arrow keys to 
add or subtract iterations.

OR select a point ON y = x, and a y = f(x) graph.

The f(x) graph can contain a constant, so the whole iteration can be 
altered by varying the value of the constant.

_______________________________________________________

♦ MACLAURIN SERIES

Select a y = f(x) function. Use the right-click option to specify the 
number of terms (max 10) to display, with or without the intermediate 
terms.  For larger ‘n’ the numerical method used can get unreliable.

The status bar gives the terms. Click on any one of the new curves to 
select it. The Animation controller can be used to vary the number of 
terms dynamically.

Newton-Raphson Iteration

Bisection Iteration

Fixed Point Iteration

Maclaurin Series
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2D: Parametric Graphing

PARAMETRIC GRAPHS: 
Use a comma to separate x(t) and y(t), either way round.
e.g.: x = ut, y = h + vt  – ½gt2 A parabola
 x = asinθ, y = bcosθ  A circle or ellipse
You can use ‘t’ or ‘θ’ [ALT-T] as the parameter. 

Startup Options:
Auto: this will do the best to ensure that the graph is plotted 
successfully. Typically this starts at t = 0, draws until the plot 
goes off-screen, then starts again at t = 0 the other way.  With trig 
functions, the defaults become t = 0 to 360°, or 0 to 2π.
Manual: set up the start, finish and step.

NOTE: The auto setting will assume the trig settings if a trig function 
occurs in the equation. Sometimes this is inappropriate, e.g.
 x = (vcosφ)t, y = (vsinφ)t – ½gt2  when manual settings for ‘t’ are 
essential. Also, these trig expressions use a ‘constant’ φ, and θ 
must be reserved for the parameter variable (shared with ‘t’).

 Slow plotting: you can pause (spacebar) and read off values of 
‘t’. The Status bar shows ‘t’, ‘x’ and ‘y’ values, to the current sig fig.

With a PARAMETRIC GRAPH selected: 
♦ Table of Values Set ‘t’ range and step.   
   ‘t’, ‘x’, ‘y’ are listed in the Results Box.
♦ Create Data set Set ‘t’ range and step.    
   A joined up XY data set is created.
♦ Asymptote Draws tangent at high value of ‘t’
♦ Evolute Draws family of tangents or normals

 Gradient (Slope) Function
This will generate, with a dotted line, the first derivative, dy/dx, for 
the current parametric curve (as selected in the Equation Key). 

 A point added to a parametric curve will be added to the 
nearest ‘nice’ value of ‘t’.  The LEFT/RIGHT arrow keys can then be 
used to move a point along the curve with the current step. Double-
click on such a point to edit the current value of ‘t’ and the value of 
the current step.

With a POINT attached to a Parametric curve:
(in addition to the usual one point options)

♦ Tangent Equation given as y = mx + c
♦ Normal Equation given as y = mx + c

♦ Velocity vector Coordinates given
♦ Acceleration vector Coordinates given

A family of parametric curves. Use the 
“Options” button on the constant controller.

A trigonometric plot using parametric
coordinates - in this case set to degrees.

A pair or straight lines plotted 
parametrically. The ± creates two plots.

A parametric representation of parabolic 
motion under gravity. Use ALT-F to enter φ. 
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2D: Polar Graphing

POLAR GRAPHS:  Any of these forms can be used:
e.g.: r = a  A circle
 r = sin2θ  A ‘flower’ 
 1/r = 1 – kcosθ A conic
 r2 = t  Two ‘branches’
 θ = nπ/8  A family of radial lines
You can use ‘t’ or ‘θ’ [ALT T] as the parameter. 

Use  Polar Axes and  Equal Aspect for the best effect.

Use  Edit Axes “Options” tab to add grid sub-divisions.

Startup Options:
Auto: this will plot θ = 0 to 360° (degrees),  or 0 to 2π (radians). 
Manual: use this to control the start, finish and step.
Plotting indicates negative values of ‘r’ with a dotted line.

 Slow plotting: you can pause and read off values of ‘θ’. ‘r’ and ‘θ’ 
are indicated visually. The status bar shows ‘t’, ‘x’ and ‘y’ values.

With a POLAR GRAPH selected (as with a Parametric): 
♦ Table of Values,  ♦ Create Data Set,  ♦ Asymptote,  ♦ Evolute.

 Gradient (Slope) Function
This will generate, with a dotted line, the first derivative, dy/dx, for the 
current polar curve (as selected in the Equation Key)
______________________________________________________

Default snap settings for ‘t’ (or ‘θ’): π/32 (radians), 4° (degrees)
These are used for dragging polar points about:

 Points attached to a polar graph
A point added to a polar curve will be added to the nearest ‘nice’ value 
of ‘t’ set by the default ‘snap setting’.  The LEFT/RIGHT arrow keys 
can then be used to move a point along the curve with the current 
step. Double-click on such a point to edit the current value of ‘t’ and 
the value of the current step.  

With a POINT attached to a Polar curve (as with a Parametric):
♦ Tangent, ♦ Normal Equations given as y = mx + c

 Free points on polar axes
A free point added to a polar axes, and selected: the point indicates 
‘r’ by joining to the origin, and ‘θ’ by showing the angle.  The point 
can be dragged about using the mouse, or moved using the ARROW 
keys:
LEFT/RIGHT ...  vary value of ‘θ’, by the current step
UP/DOWN ...  vary value of ‘r’, by the current step
(+ Ctrl: , + Shift to vary the step /10 and /100 as usual).

Plotting a polar graph slowly gives a 
chance to show the value of ‘r’ and ‘θ’

When values of ‘r’ go negative 
the plotting is dotted 

A family of conics using a comma 
separated list of values for ‘k’

A selected point on a polar graph page 
shows its values of ‘r’ and ‘θ’ dynamically.
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2D: Differential Equations

1st ORDER DIFFERENTIAL EQUATIONS
Equations can be entered using y’ or dy/dx, eg:

Variables y-x: y’ = y/x y’ + ky = x dy/dx = x 
Variables x-t, or v-t: ẋ = 2t2  = sint 

 Use “Edit Axes” to set the variables, or ...

 Use “Re-label x-t” to set the axes quickly to x-t
With independent variable ‘t’: x’ and v’ become ẋ and .

STARTUP OPTIONS: If you are happy with the default 
settings, there is no need to visit this dialogue box.

♦ Initial Conditions
Manual - solutions are started for each mouse click. These 
are plotted slowly if “Slow Plot” mode is on. 
Point - for this you need a selected single point before you 
enter the start-up options. A solution is drawn from this point, 
which can be dragged about.
Point Set - use the “Enter Start Points” to set up a number of 
start points in a straight line, either along one of the axes, or 
between two entered points.

♦ Step Size
The “Runge-Kutta” method is employed, and it works fine in 
most cases, switching from x-stepping to y-stepping when 
the slope gets steep. Here you can control the x- or y- step 
if required. With “Auto” ticked, solutions are generated in 
positive and negative directions from the start point.

♦ Options: 
Show Slope Field - 21 instances of the slope in each of the ‘x’ 
and ‘y’ directions are indicated by small tangents.
Stop at first off-screen - solutions can plot forever off-screen.
Iterations - a safeguard to prevent solutions going on forever. 

Here, the variables have been changed to ‘v’ and ‘t’.
Entering v’ will change automatically to .

The slope field is optional.

The Runge-Kutta numerical method is 
adequate for most 1st order situations.

Here, the solutions are circular.
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2nd ORDER  DIFFERENTIAL EQUATIONS
Equations can be entered using y” or d²y/dx² , e.g.:
Variables y-x: y” = x y” + y’ = 3
Variables x-t: ẍ + 2λẋ + x = sint

 Use “Edit Axes” to set the variables, or ...

 Use “Re-label x-t” to set the axes quickly to x-t
When the independent variable is ‘t’:  x’, x” become ẋ and ẍ.

STARTUP OPTIONS: If you are happy with the default 
settings, there is no need to visit this dialogue box. A second 
order equation requires two initial conditions - Autograph uses 
an initial point and initial slope.

♦ Initial Point
Manual - solutions are started for each mouse click. 
Point - for this you need a selected single point before you 
enter the start-up options. A solution is drawn from this point, 
which can be dragged about.
Point Set - use the “Enter Start Points” to set up a number of 
start points in a straight line, either along one of the axes, or 
between two entered points.

♦ Initial Slope
Here, set the initial value, or a comma separated list.

♦ Step Size
A modified “Runge-Kutta” method is employed, and it works 
fine in most cases. Only the independent variable, ‘x’ or ‘t’, is 
stepped, and you can control the step if required. 

♦ Options: 
Draw gradient - this plots the 1st derivative, dy/dx or dx/dt, 
along with the main solution. 
Stop at first off-screen - solutions can plot forever off-screen.

Damped SHM. The values of ‘λ’ (damping factor) and
‘n’  (natural frequency) can be varied. Note the implicit 

form for the differential equation.

A representation of motion under gravity. 
All the computer has been told is:  ẍ = –g

and the intitial conditions: x(0) = 4, ẋ(0) = 3

A nice illustration of the integration process.
y” = x   =>   y’ = ½x² + c   =>   y = ⅙x³ +cx + d
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3D PAGE: XYZ Graphing
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3D: Standard and Advanced

MAIN
toolbar

3D
toolbar

The 3D page 
opens with the 

3D Toolbar
and these standard x-y-z 
axes and bounding cube.

THE 3D PAGE: 
The TOP LEVEL 

RIGHT CLICK MENU

♦  Enter Equation  [Advanced Level only] 
 [Pressing ENTER also opens this]
 The type of equation is detected automatically. Constants can be
 included; Start-up options will depend on the type of equation.

♦ Enter Co-ordinates
 You can use numbers, expressions or constants. 

♦ Enter Vector Line  [Advanced Level only]
 A line in the form:  [x,y,z] = [a,b,c] + λ[g,f,h]

♦ Enter Vector Plane  [Advanced Level only]
 A plane in the form:  [x,y,z] = [a,b,c] + λ[f,g,h] + µ[l,m,n]

♦ Enter Shape
 A choice of ‘preset’ shapes, or enter a set of coordinates.

The equation key is 
present by default at the bottom 

of a 3D Advanced level page, 
but not at the Standard Level.

The default background 
is black, 

but this can be changed to 
“Medium” or “White”.
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THE 3D MODES TOOLBAR

The Modes toolbar has been modified to suit the needs 
of the 3D environment.

 Select mode: there are no mouse indications
 on a 3D page (to improve speed). When not 
 hovering over an object, the select mode 
 behaves like the Drag tool.

 Point tool: A point is placed in 3D halfway
 through the bounding cube, along the eye-line.
 Double-click on a point to edit its coordinates.

 [It is not practicable to draw in 3D!]

 Rubout tool 

 Drag tool: This rotates the whole scene about.

  + CTRL: DOWN/UP
  This zooms the camera IN/OUT

  + SHIFT: 
  This moves the ‘camera’ about.

      Zooms: zooms all the axes, centre in the
  middle of the cube along the eye-line

        This zooms only the x-axis

    This zooms only the y-axis

    This zooms only the z-axis

THE 3D GRAPHING TOOLBAR

  Restores the x-y-z orientation to the default/ 
 This is particularly useful after using the Drag tool
 with CRTL to restore the original orientation.

 Hides the z-axis for y-x plotting in 3D, and
 re-orientates with ‘y’ axis vertical. This is 
 particularly useful for Volumes of Revolution.

 Sets or restores default ranges.
 Useful if in a muddle after zooming.
 Will put ‘x’ and ‘y’ π scales in for trig functions.

 Dark background (default) - good for surfaces.

  Medium background - good for Whiteboards.

 White backgrounds.
 each has amended axes’ colours to match.

 Show/hide 3D grid.
 Show/hide 3D box.

.

 Add Equation (*)
 Add vector equation of a line (*)
   Add vector equation of a plane (*)

 (*) Advanced Level only.

 Add 3D shape (including defaults).

 Add Coordinates for a point.
.

  Revisit the start-up options and replot a graph.

     - used to control 3D object animation.

STANDARD and ADVANCED 3D 

The Standard level in 3D does not offer equations, or 
the vector equations of a line, or a plane, but otherwise 
the two levels operate in the same way. 

There is a ‘bounding cube’ inside which all the action 
takes place. It is not possible to scribble, or put on a text 
box in 3D as both would have to be fully implemented 
3D objects. 

3D: Graphing Toolbar

USEFUL TOOLS in the MAIN Toolbar 

  Key below/right, works as in 2D.

  Angle settings.

  Constant controller and Animation. 

   Thickness applies to lines only.

  Standard Level only: Snap=1 is the default.
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3D: How Does It Work?

 ADDING POINTS IN 3D

Points in the 3D environment are represented by small 
cubes, and selected points have a small extra ‘layer’. 
There is no distinction given to the ‘current’ point.

The point mode is used to add points just as in 2D. 
When the mouse is NOT over an existing object, the 
points are ‘free’, and follow the rule that they are placed 
halfway through the bounding cube. The coordinates 
can of course be edited (double-click). 

A point added while the mouse is over an object (eg a 
plane) is ‘attached’ to the object.  Double-click on an 
attached point to edit the coordinates (usually only the 
‘x’ and ‘y’ values).

 Use “Enter coordinates” to enter exact 
coordinates, eg (2π/3, 1, 2) or constants can be used, 
e.g. (a, b, c).

To move a point, either drag it with the mouse (when it 
will follow the location rule above), or, better use the ...

Arrow keys: Left//Right adjusts the ‘x’ value
 Up/Down  adjusts the ‘y’ value
 PgUp/PgDn  adjusts the ‘z’ value.

The incremental step is also controlled as in 2D, and 
relative to the grid spacing: 0.1, otherwise hold CTRL: 
0.01 and SHIFT-CTRL: 0.001. 

  In the Standard Level, all these increments are 
multiplied by 10 when the integer snap is on.

Ranges, Labels, Options:

These are the same as 2D, except the ‘Options’ 
defaults are:  
Axes: always outside, with arrows and a bounding box.

APPEARANCE:

      Background: it is usually better to use 
the three toolbar buttons, as the axes colours are 
adjusted to fit automatically.

Transparency: the 3D equation Entry “Draw options” 
allows colour and transparency of surfaces to be set, 
but generally it is better to set transparency for all 
surfaces (here) rather than just one. 

Lighting: Here you can set “Ambient Light”, 
“Reflectance” and “Sharpness”, as well as add more 
lights. What you can do will depend on the capabilities 
of your graphics card.
____________________________________________

,  DRAG and ZOOM in 3D
This very versatile ‘drag’ feature is duplicated in select 
mode when not over an object. You can drag the scene 
round with the left mouse button pressed. 

+ CTRL: you can zoom the ‘camera’ in and out of the 
 scene by moving the mouse UP and DOWN.
+ SHIFT: you can move the ‘camera’  about. 

With a single point selected, use the option “Coordinate 
Box” to show clearly what the coordinates are.

 EDIT AXES in 3D
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3D: Straight Lines and Planes

STRAIGHT LINES in 3D
All lines are given in the Status Bar as: [x, y, z] = [a, b, c] + λ[f, g, h]

ONE POINT selected:
♦ Line // x-axis ♦ Line // y-axis ♦ Line // z-axis

TWO POINTS selected:
♦ Straight Line 
♦ Line Segment Distance given
♦ Gradient Δx, Δy, Δz given

  Vector Line [x, y, z] = [a, b, c] + λ[f, g, h]
A straight line can also be entered directly in vector form 

ONE POINT attached to a PLANE or SURFACE
♦ Normal Line

TWO PLANES selected
♦ Intersection line

ONE POINT and a VECTOR selected
♦ Line from vector 
________________________________________________
PLANES in 3D
Planes are given in the Status Bar as: ax + by + cz = 1 or in vector 
form [x, y, z] = [a, b, c] + λ[f, g, h] + μ[l, m, n], as appropriate.

ONE POINT selected:    
♦ Plane ⊥ x-axis, or ⊥ y-axis, or ⊥ z-axis

THREE POINTS selected, or
ONE POINT and a STRAIGHT LINE or VECTOR selected
♦ Plane  (vector // the plane)

ONE POINT and a VECTOR selected
♦ Plane from Vector  (vector ⊥ the plane)

ONE POINT and TWO VECTORS selected
♦ Plane [x, y, z] = [a, b, c] + λ[f, g, h] + μ[l, m, n]

 Vector plane can be entered directly in the form
 [x, y, z] = [a, b, c] + λ[f, g, h] + μ[l, m, n]

    Equations of planes can be entered directly
eg: x = k,  y = k,  x + y = k,  ax + by + cz = d

ONE POINT attached to a STRAIGHT LINE selected:
♦ Perpendicular Plane 

ONE POINT attached to a z = f(x, y) SURFACE selected:
♦ Tangent Plane (small or full)

ONE POINT and a VECTOR selected
♦ Plane from vector (perpendicular to the vector)

The Straight line (0, −3, 0) and (0, 0, 2): [x, 
y, z] = [0, –3, 0] + λ[0, 3, 2]

Intersection of two planes: [x,y,z] = [0,1,1] + 
λ[1,0,0]; Angle between planes = 45°

Plane through three points (0, –2, 0), (2, 0, 
0) and (0, 0, 2) : 0.5x – 0.5y + 0.5z = 1

Tangent plane to a paraboloid. All results 
obtained from “Page” => “Copy Status Bar”.
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3D: Vectors

VECTORS in 3D

VECTOR CREATED FROM A SINGLE POINT
As in 2D, a 3D vector must have a point to ‘sit’ on, so to create a 
vector you must have a point selected.  Use the right-click option 
“Vector” and enter the Cartesian coordinates [x, y, z], or the Polar 
Coordinates [r, θ, φ]. If constants are used here, these can be 
altered using the Constant Controller.  

The vector can be moved by dragging the base point. 

VECTOR CREATED FROM TWO POINTS
Alternatively, a vector can be created between two selected points, 
making it moveable at either end.

A vector consists of three objects: base point, end point and stem 
(with an arrow at the mid point).  A vector is selected by clicking on 
its stem.
______________________________________________________

With ONE VECTOR [a, b, c] and a POINT [l, m, n] selected, a new 
vector can be created based on the point as follows:

♦ Negative vector [–a, –b, –c]
♦ Copy vector [a, b, c]
♦ Unit vector [a/r, b/r, c/r],  r = √(a² + b² + c²)
♦ Multiply vector (enter factor) [ka, kb, kc]
   This creates a scalar multiple of the original vector. 
    ‘k’ can animated.

♦ Line from vector [x, y, z] = [l, m, n] + λ[a, b, c]

♦ Closest point, and distance  
 on the line of the vector 

TWO VECTORS [a, b, c] and [l, m, n] selected, 
♦ Angle between two vectors (*) degrees or radians 
♦ Scalar (or Dot) Product (*) al + bm + cn
   (*) given in the Results Box

TWO VECTORS [a, b, c] and [l, m, n] 
and a POINT [p, q, r] selected, a new vector can be created based 
on the point as follows:

♦ Add vectors [a + l, b + m, c + n]
♦ Subtract vectors [a – l, b – m, c – n]
♦ Cross Product 

With a POINT and a PLANE or z = f(x,y) SURFACE selected
♦ Normal Unit Vector
♦ Normal Line

As in 2D, there are two vector definitions:
enter the coordinates, or join two points.

The sum of two vectors: use of the drag 
zoom to show they are in the same plane.

An example of a scalar multiple of a vector, 
and the closest distance from a point.

Two vector from three (draggable) points 
attached to a plane, at their cross product.



www.autograph-maths.com 71

3D

3D: Calculations

CALCULATED POINTS in 3D

As in 2D, “Calculated Points”  are not added to the set of points, 
and are indicated by a small coloured cube.  They can be selected 
(for deletion), and a point can be attached to a calculated point.

STRAIGHT LINE and a PLANE selected
♦ Intersection point

THREE PLANES selected
♦ Intersection point

TWO POINTS selected
♦ Mid Point

THREE or more POINTS selected
♦ Centroid

______________________________________________________

CLOSEST DISTANCES in 3D

The Status Bar gives coordinates of the end point(s), the distance, 
and angle as appropriate.

ONE POINT and a PLANE selected
♦ Closest point

ONE POINT and any LINE or VECTOR selected
♦ Closest point

TWO STRAIGHT LINES selected
♦ Closest distance

______________________________________________________

CALCULATED ANGLES in 3D

Given the results box, in degrees or radians. A “LINE” here means a 
Straight Line, Vector or Line Segment.

TWO LINES (or any combination) selected
 
ONE STRAIGHT LINE and a PLANE selected

TWO PLANES selected

A point is attached to the intersection 
between a vector line and a plane.

Planes can be entered as implicit or vector 
equations, or created from 3 points.

The shortest distance between two lines.
Status bar gives the distance and the angle.

A 3D shape made up of line segments. 
Select any two to find the angle.
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3D: Shapes and Transformations

A 3D shape (blue) created from four points, 
enlarged through a point to a purple shape.
___________________________________

CREATING A SHAPE in 3D

 A shape in 3D must necessarily be made up of triangles. To 
create a finished shape there are several options:

1. Use “Enter Shape”, and select one of the Presets (all five of the 
Pentatonic solids):

♦ Tetrahedron   4 points,    4 triangles  or   6 lines   
♦ Octahedron   6 points,    8 triangles  or 12 lines
♦ Cube   8 points,  12 triangles  or 12 lines
♦ Icosahedron 16 points,  20 triangles  or 30 lines
♦ Dodecahedron 20 points,  36 triangles  or 32 lines

The default is to use filled triangles, to give the shape a solid 
appearance, but there is the option to show unfilled triangles, or 
lines only.

2. If you know the coordinates of all the points, use “Enter Shape” 
and enter the coordinates manually. Then, 3 points at a time, click 
“Add” to add them to the list of triangles that will make up the shape. 
Alternatively, select two points at a time and create a list of Lines.

3. Select 3 points and use “Group to Shape”. To extend the shape, 
select a new point and two of the existing shape’s points and use 
“Group to Shape” again, and so on.

______________________________________________________

TRANSFORMING A SHAPE in 3D

To select a shape, click on one of its solid sides. If it is “Lines” only, 
click on one of the lines.

ONE SHAPE selected
♦ Rotation about x-axis ♦ Reflection in the plane x = 0
♦ Rotation about y-axis ♦ Reflection in the plane y = 0
♦ Rotation about z-axis ♦ Reflection in the plane z = 0
♦ MATRIX transformation

ONE SHAPE and ONE POINT selected

♦ Enlargement   Scale factor can be animated

ONE SHAPE and ONE LINE selected

♦ Rotation   Angle can be animated

ONE SHAPE and ONE PLANE selected
♦ Reflection

Transformations 
by 3D MATRIX

User defined: enter your own elements (by 
columns); press “Inverse” to change to the 
elements of the Inverse Matrix.

Presets: The following are available:

Rotation about x-axis
     1   0   0 
     0   cosθ –sinθ 
     0   sinθ   cosθ 

Rotation about y-axis
     cosθ   0   sinθ 
     0   1   0 
   –sinθ   0   cosθ 

Rotation about z-axis
     cosθ –sinθ   0 
     sinθ   cosθ   0 
     0   0   1 

Enlargement
     k   0   0 
     0   k   0 
      0   0   k 

  If any of the elements contain 
constants, these can be controlled by the 
constant controller.

  With the transformed shape selected, 
use the Animation controller to apply the 
matrix ‘n’ times (n = –1 is equivalent to the 
inverse matrix).
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3D: Entering Equations

Autograph interprets the entered equation according to its form:

Surface: EXPLICIT EQUATIONS: z = f(x,y)

e.g.: Egg box: z = asinxcosy
 Saddle: z = x² – y² 
 Paraboloid: z = x² + y² 

Start-up Options: you can to set the number of ‘x’ and ‘y’
divisions (default 50 x 50) to a max of xy = 200 000 (e.g. 400 x 
400). Higher settings will be very slow to plot, and could run out of 
graphics memory!

Surface: 1st DEGREE IMPLICIT EQUATIONS

These are rearranged internally as z = f(x,y)
e.g.: Plane:  ax + by + cz =  d
this is equivalent to the vector equation:  
 [x, y, z].[a, b, c] = d,   or   r. n = d

ADDING A POINT TO A SURFACE
A moveable point can be placed on any of the above. 
For a given (x, y), ‘z’ will be calculated to place it on the surface.
The following right-click options are available:

♦ Normal Line:  [a, b, c] + λ[l, m, n]
♦ Normal Unit Vector:  [a, b, c] 
♦ Tangent Plane (small or large): ax + by + cz = 1

____________________________________________________

Surface: GENERAL IMPLICIT EQUATIONS

These plots are not interpreted as functions, so points cannot 
be placed on them. The plotting system used is generally very 
satisfactory, but it can be less than successful when the plotting 
involves tight corners. The quality can be improved by increasing 
the resolution in “Startup options” in the Equation Entry box: x-
div = 16 is the default. Up to x-div =30 is acceptable.

e.g. Box: |x| + |y| = r
 Schwarz’s surface:  cosx + cosy + cosz = 0
 Cone:  x² + y² = z²  [or cylindrical polar: r = z]
 Sphere:  x² + y² + z² = r²   

 Cylinder:  x² + y² = a²  [or cylindrical polar: r = a]
  x² + z² = a²
  y² + z² = a²

3D Equation entry is very similar to 2D. 
“zz” enters z². Each equation has its own 

appropriate “Start-up Options”.

Use “Plot as 2D” option when there is no 
‘z’, and you want to have no ‘z’ plotting at all 

(eg for Volumes of Revolution).

“Draw Options”: set surface colour, 
and transparency here.

A z = f(x, y) equation with a point attached, 
and a tangent plane and normal unit vector.

A cone, entered as r = z, and an 
intersecting plane, entered as z = ax + b
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3D: Volume of Revolution

Autograph’s 3D environment provides a natural setting for the study 
of volumes of revolution. The sequence to follow is:

  1. Select “x-y Orientation” on a 3D page

  2. Enter a y = f(x) graph, and select “Plot as 2D”
e.g.: y = sinx, or 2y = 4 – x²

  3. Create an area under the curve
Either: select the graph or: select two points attached to the graph
Then use the right-click option “Area”. This works exactly as it does 
in 2D with the four options:
  Rectangle (+), Rectangle (–), Trapezium Rule, Simpson’s Rule
and enter the x-limits for the area (if not already defined by points)
and enter the number of divisions (which can be altered dynamically 
later on).  
“Show Centroid”: (, ) for the area as a “calculated” point.

  4. “Slow Plot”: you will see the volume open out slowly. 

  5. Select the area. Use the right-click option “Find Volume”. 
Enter axis of rotation y = ... (Enter a number or a constant. The 
default: y = 0, the x-axis).
“Show Centroid”: (, , 0) for the volume as a “calculated” point.
Status Bar: shows volume (as multiple of π, and area).

  6. Select the volume: use the “Animation Controller” to vary
 (a) the Volume (from 0 to 2π, or 360°)
 (b) the number of divisions
These can be varied manually using the Up/Down arrow keys, or 
using the “Animate” options.

Using Simpson’s Rule, the volume will appear very smooth, and 
the calculation (in the status bar) will be the most accurate.
______________________________________________________

OTHER OPTIONS

♦ Volume between x = f(y) and a x = k axis
Everything works the other way round.

♦ Volume of an area between two functions
Create an area as in 2D: select the two functions, or select one 
point on each curve.

♦ Volume of revolution of an area about any straight line.
Select the area and any straight line. The resulting volume is 
created but sloping lines are not calculated!

Volumes can be created between any two 
curves and about any straight line. Here 

Simpson’s Rule creates a smooth surface.

Using Slow Plot, the volume can unfold 
slowly. The animation controller can also do 

this manually, or automatically.

The area between 2y = 4 - x² and the x-axis 
is rotated about the x-axis (or any axis 

entered in the Edit Volume box).

Here you enter the axis of revolution y = ... 
and you can also edit the Area settings



www.autograph-maths.com 75

3D

3D: Parametric and Polar Equations

PARAMETRIC EQUATIONS
x = f(t), y = g(t), z = h(t)

These are all LINES in 3D, each point (x, y, z) depending on the 
value of the parameter ‘t’. To make the line thicker (or a different 
colour), use “Draw Options” in the Equation entry box, or select the 
drawn line, and use the Line Thickness button. Thick lines in 3D are 
drawn as cylinders.  The range and step for ‘t’ is set in the Start-Up 
options as follows:

Generally:  –5, 5  step 0.1
Trig functions (radians):    0, 2π  step π/25
Trig functions (degrees):   0, 360°  step 4°

e.g.: spiral  x = sint, y = cost, z = t 
 pair of straight lines  x = t, y = ±t, z = 0

With a (moveable) POINT attached to a parametric graph, you can 
find the:
♦ Tangent  [a, b, c] + λ[l, m, n]
♦ Normal plane (large or small) ax + by + cz = 1
♦ Velocity Vector  [a, b, c]
♦ Acceleration Vector [a, b, c]
______________________________________________________

CYLINDRICAL POLAR
r = f(θ, z)  or  r² = f(θ, z)  or  1/r = f(θ, z)  

In the Equation Entry box, there is the option to select ‘r= ..’ 
to be interpreted as cylindrical or spherical coordinates. Any 2D 
polar equation can also be interpreted as a Cylindrical Polar.

e.g.: cylinder: r = 1  
 triangular prism, box: r = 1 
 (use θ-step set to 2π/3 or π/2, in “Startup Options”)
 cone: r = z 
______________________________________________________ 
 
SPHERICAL POLAR
r = f(θ, φ)  [ALT-T = θ]  [ALT-F=φ]  

e.g.: sphere: r = 1
 shell on the shore! r = 1.3^θ sinφ

Spherical Polar coordinates can also be entered parametrically:  
 x = f(θ,φ), y = f(θ,φ), z = f(θ,φ) 
e.g.: torus:   x=cos(θ)(p+qcos(φ)), y=sin(θ)(p+qcos(φ)), z=qsin(φ)

To convert from Spherical Polar to Parametric Form:
 r = f(θ,φ) =>    x = rsinφcosθ, y = rsinφsinθ, z = rcosφ

CYLINDRICAL POLAR:
 r = f(θ, z)

SPHERICAL POLAR:   
r = f(θ, φ) 

A parametric spiral, with a point attached, 
and tangent, normal plane, velocity and 
acceleration vectors created. This image 

used the camera zoom on the “Drag” mode.

A bit of fun with a spherical coordinate plot, 
r = cos2θ + kφ

and its intersection with the plane z = 0.
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Using Autograph Help [F1]

 The Autograph Help consists of nearly 300 
interlinked pages. Press F1 any time that Autograph 
is running, or go to “Help” => “Autograph Help”. 
Alternatively, the Help file can be found in “Start” => “All 
Programs” => “Autograph 3.20” => “Help”.

There are four accordian items on the left:
CONTENTS offers an expandible list capable of 
showing every page in the help system. 
SEARCH allows a powerful keyword search of the 
entire contents.
BOOKMARKS lists your bookmarked searches and 
topics. 
INDEX provides an alphabetical list of key points.

EXAMPLE EQUATIONS
This section lists a number of equations in each of the 
following categories. Any equation can be selected and 
copied into the 2D or 3D “Add Equation” dialogue box:

2D Graphing Page
Cartesian y = f(x) Cartesian x = f(y)
Trigonometric Inverse Trig
Exponential Hyperbolic
Implicit => y = f(x) Conics
General Implicit Fun Equations
Inequalities Piecewise
Function Definitions Evolutes
Parametric Equations Polar Equations
1st Order Diff. Eqns 2nd Order Diff. Eqns
 
3D Graphing Page
z = f(x, y) Implicit equations
Intersections with a cone Parametric Coordinates
Spherical polar Cylindrical polar

FORMULAE
This section is a comprehensive list of formulae for school 
and college mathematics. Any formulae can be selected 
and pasted (e.g. into Word). All symbols are provided by 
the “Arial for Autograph” font.

Pure Mathematics
1. Logarithms, Exponentials 2. Trigonometry 
3. Radians and Degrees 4. Maclaurin Expansions
5. Differentiation 6. Integration

Probability and Statistics
1. Sample Statistics  2. Population Statistics 
3. Selections  4. Discrete Prob. Distr.  
5. Continuous Prob. Distr.  6. Central Limit Theorem

Other Formulae
Numerical Methods for finding the area under a curve
Matrix Transformations
Differential Equations: Numerical methods

CONTEXT SENSITIVE HELP 
Most Autograph dialogue boxes have a “Help” button. 
This will take you to the appropriate page in the Help 
system:
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One of the best ways to get to see what Autograph 
is capable of is to view the Tutorials.
 
1. In the Help File
A number of tutorials have been included in the 
Help application in the final section, and appropriate 
tutorials are linked from individual help pages. It may 
be necessary to open out the Help window a bit in 
order to view them satisfactorily.
 
 
2. On the Autograph Web Site 

From the Autograph home page,  
click on the ‘Autograph In Action’ link for the page 
containing the contents of the Tutorials. 

__________________________________________ 

TurboDemo
The tutorials have each been created by recording 
a series of screen-shots while Autograph is running. 
The TurboDemo application has been used for this, 
allowing visual effects and explanatory text ‘bubbles’ 
to be added.   
 
TurboDemo tutorials give the appearance of a real-
time movie, but are in fact a set of discrete images, 
but with the mouse movements joined up.

The tutorial contents list has been arranged to reflect 
the two ‘levels’ of Autograph: 
   Standard
   Advanced.  

Within those two levels topics are also arranged to 
match the three ‘page’ types in Autograph:
   Statistics and Probability
   2D Graphing
   3D Graphing

All the tutorials are based on classroom experience. Here 
the important link between ln|x| and logx can be visualised.

Using Autograph Tutorials [F3]

All the Autograph tutorials can be controlled by the slider (to move quickly to a particular frame), or by the buttons 
which give the usual options: back to the start, back one frame, play/pause, forward one frame, forward to the end. 

The 3D pages of Autograph are especially effective in 
tutorials. Here the conic sections are being explored.
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The ‘Arial for Autograph Uni’ Font

The ARIAL FOR AUTOGRAPH’ Unicode font has been specially commissioned from Monotype Imaging (UK) to 
include as many characters as possible that are useful in school/college level mathematics. These characters are 
available for use in Autograph, as well as any other application that handles text (e.g. Word).

On the keyboard:    | ~   
Off keyboard, non-Unicode: ° ± 2 3 ÷ × – 
  
Circumflex:      â  ĉ î ĵ    ȓ  ŝ   û ŷ     
Dots and bars:     ẋ ẏ ṙ   ṡ  ż  ẍ ÿ        

Superscripts:      –1 2 3 4 5 6 7 8 9 + –  n x –x y –y r

Subscripts:      1 2 3 4 5 6 7 8 9 + –  n  a i ( ) = 0 

Greek Alphabet:     Α  Β  Γ  Δ  Ε  Ζ  Η  Θ  Ι  Κ  Λ  Μ  Ν  Ξ  Ο  Π  Ρ  Σ  Τ  Υ  Φ  Χ  Ψ  Ω 
        α  β  γ   δ   ε  ζ   η   θ  ι   κ   λ  μ   ν   ξ   ο  π  ρ   σ  τ   υ  φ  χ   ψ  ω 

Fractions:       ½  ⅓ ⅔ ¼ ¾ ⅕ ⅖ ⅗ ⅘ ⅙ ⅚ ⅛ ⅜ ⅝ ⅞   
Miscellaneous:     € ℓ Å  ℂ ℕ ℙ ℚ ℝ ℤ  

Arrows:       ← ↑ → ↓ ↔ ↕ ↖ ↗ ↘ ↙ ↞ ↟ ↠ ↡ ↲ 
        ↶ ↷ ↹ ↺ ↻ ⇏ ⇐ ⇑ ⇒ ⇓ ⇔ ⇕ ⇖ ⇗ ⇘ ⇙

Mathematical symbols:   ∧ ∨ ⊂ ⊃ ∩ ∪ ⊄ ⊅ ⊆ ⊇ ∈ ∉ ∅  ≃ ≈ ≏ ≠ ≡ ≤ ≥
         ∀ ∃ ∂ ∆ ∏ ∑ ∫ ∝ ∞ ∡ ⊥ – ∴ ∵ ∶  √ ∛  

Miscellaneous symbols:   † ‡ • …  ❛ ❜ ❝ ❞ ⊗ ⊙ ◯ ☼ ☹ ☺ ♀ ♂ ⌘ ⌚ ⌛ ⌨
        ☁ ☂ ☐ ☑ ☒ ✓ ✗  ❏ ❄ ❖ ✍  ✎ ☜ ☝ ☞ ☟ ✁ ✂ ✈ ✉   

Chess and playing cards:  ♔ ♕ ♖ ♗ ♘ ♙ ♚ ♛ ♜ ♝ ♞ ♟ ♠ ♥ ♦ ♣ ♤ ♡ ♢ ♧ 
Music:       ♩ ♪ ♫ ♬ ♭ ♯ ♮ 

Large brackets :             
                
                

______________________________________________________________________________________________
 
Use of Unicode Fonts generally 
 
All the above are in their standard UNICODE positions, so will work in all FULL Unicode fonts, e.g. Arial Unicode MS, 
EXCEPT the large brackets and following, which have been added as Arial for Autograph Private Use Characters:

 –1 x –x –y 
a i n                      

 
Expressions which do not involve these ‘Private Use’ characters will appear correctly rendered using any standard 
Unicode font in any document, email, web site,  etc. Such expressions can be freely copied into Autograph, or pasted 
out.
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Finding Useful Characters 
 
A number of mathematical symbols exist in the early 
pre-256 font positions, which can be entered using ALT 
and their ASCII decimal code (on the key-pad),  
eg ‘x’ followed by ALT 0178 will enter x²:

0128 0149 0150 0176 0177 0178
€ • − ° ± ²  

0179 0188 0189 0190 0215 0247 
³ ¼ ½ ¾ × ÷
____________________________________________ 
 
When running Autograph, a number of useful 
characters can be entered any time using the ALT key,
eg ‘x’ followed by ALT 1 will enter x–1 : 

ALT  1 2 3 4 5 6 7 8 9 X Y N
Indices x–1 x2 x3 x4 x5 x6 x7 x8 x9 ex ey xn

 
ALT A B E F G L M S P T
Greek α β ε φ γ λ μ σ π θ
 ‘PI’ also enters π 

ALT 0 - + H < > R O C 
Maths ∞ – ± ½ ≤ ≥ √ ° ∛ 
 ‘<=’, ‘>=’ also enter ≤, ≥ 
____________________________________________

 Using Character Map

The complete Arial for Autograph Unicode font can be 
explored using the Windows utility Character Map. This 
can usually be found in
Start => Programs => Accessories => System Tools

You can use ‘Right-click drag’ to create a short-cut to 
this, eg on the desktop, or in the Start Menu.

After you have opened Character Map:
- Find the font Arial for Autograph Uni in the font list
- Click on any character you want to copy
- Click select adds it to the list of Characters to copy
- press Copy: the characters are now on the clipboard.

Using Character Map to explore the font:
- Tick Advanced View
- set Character Set to Unicode
- Group by Unicode Subrange

  The Autograph on-screen keyboard will also 
deliver a wide range of mathematical symbols into 
whatever application is running (eg Word).

To launch the On-screen Keyboard withough running 
Autograph, go to Start => Programs => Autograph 3.20 
=> Keyboard. 

Since most of the common mathematical symbols 
are in their standard Unicode positions, delivering the 
symbols does not require the Arial for Autogrpah Uni 
font, unless you are wanting to use symbols from the 
Private Use area.
____________________________________________

MINUS SIGN:    
 
It is very important that mathematical expressions use a 
proper MINUS sign ‘–’ and not the hyphen ‘-’.  This can 
always be added to any document using ALT 0150.

Within Autograph itself, the hyphen enters a MINUS 
when you are typing in equations.

Another source for the MINUS is on the Autograph 
onscreen Keyboard, using the “Data Entry” panel.

___________________________________________
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The Autograph Extras

In the “File” menu => “New Extras Page”, there are SIX interactive flash demonstrations, each of which will open in a 
new, sizeable Autograph page. They are also found in the “Autograph Resources” application [F3].  

 AREA OF CIRCLE

An animation of the limit of n sectors of a unit circle 
placed back to back. In the limit, this illustrates that the 
area of a circle = �r².

Control buttons:
 ○ Restart
 ○ Increment ‘n’ down by 1
 ○ Increment ‘n’ up by 1
 ○ Go to ‘n’ = 360
 ○ Show information

 TRIGONOMETRY

An animation showing the link between the unit circle 
and the three (circular) trigonometric functions. 

Control buttons:
 ○ Restart
 ○ Increment ‘θ’ down by 15° (can go beyond 360°)
 ○ Increment ‘θ’ up by 15° (can go below 0°)
 ○ Go to ‘θ’ = 360
 ○ Switch Degrees/Radians (starts in Degrees)
 ○ SIN, COS, TAN - on/off
 ○ Automatic demonstration

 MONTE CARLO - π

This simulation of random points in a unit circle inside a 
square of side 2, leading to:  
  π ≈ (Points within the circle/Total Points)*4
Opening option: Auto (up to n = 10,000) and fixed.

Control buttons:
 ○ Opening option again
 ○ Restart the simulation
 ○ Increment ‘n’ a few up (if paused)
 ○ Pause/resume
 ○ Slider: 4 levels of zoom
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 DICE SIMULATION

A simulation of throwing dice. 
Opening option: Auto / Fixed number (max 9999) 

Control buttons: (Starts paused)
 ○ Opening Options
 ○ Restart
 ○ Start / Pause
 ○ Display mean, μ
 ○ Display SD, σ
 ○ Display χ²
 ○ Display Actual frequencies
 ○ Display Theoretical Frequencies

TWO FURTHER EXTRAS for the Advanced Level only

 CONFIDENCE INTERVALS

For each of 100 samples of size ‘n’ (default = 5, max 
30), the confidence intervals are shown, and those not 
including the population mean (zero) are highlighted.
Choice of Confidence levels: 90%, 95%, 99%. 

Control buttons: (Starts paused)
 ○ Opening Options
 ○ Restart
 ○ Start / Pause
 ○ Increment the simulation

 POISSON GRID

A simulation of ‘n’ (default 200, max 1000) random 
points falling on a square 10 x 10 grid. Frequencies 
are counted for the squares that contain 0, 1, 2, 3, ... 
points. The distribution is compared with the theoretical 
Poisson distribution, with λ = n/100

Control buttons: (Starts paused)
 ○ Opening Options
 ○ Restart
 ○ Start / Pause

DICE SIMULATION options:
1 Die - Sum of 2 Dice - Difference of 2 Dice
Maximum of 2 Dice - Sum of ‘n’ Dice (max 25)

  Confidence level = 90%: Interval   ± 1.64σ/√n
  Confidence level = 95%: Interval   ± 1.96σ/√n
  Confidence level = 99%: Interval   ± 2.58σ/√n
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♦ SAMPLE STATISTICS

Size of sample:  n = Σf
Mean:  = (1/n)Σ(fx)
Variance: s²(x) = (1/n)Σf(x – )²  = (1/n)Σfx² – ²
Coding: y = ax + b,    = a + b,   s²(y) = a² s²(x)
Covariance: 
  cov(xy) = (1/n)Σ(x – )(y – )  =  (1/n)Σxy –
Product Moment Correlation Coefficient, PMCC:
  r = cov(xy)/(s(x)s(y))
Least-Squares Regression Line, y-on-x:
  y –  = cov(x,y)/s²(x).(x – )
OR  y = a + bx, 
where:  Σy = na + bΣx and  Σxy = aΣx + bΣx²
Least-Squares Regression Line, x-on-y:
  x –  = cov(x,y)/s²(y).(y – )

Spearman’s Rank Correlation Coefficient:
  r(s) = 1 – (6Σd²)/(n(n² – 1)
where:   d = difference between the rankings

♦ POPULATION STATISITICS

Expectation: 
  μ = E[X] = Σpx    where p = P(X=x)
Variance: σ² = Var(X) = E[X – μ]² = E[X²]  – μ² 
      = Σp(X – μ)² = Σpx² – μ²
Coding: E[ax + b] = aE[x]+b    Var(aX+b) = a²Var(X)

Selections and Combinations
   nPr = n!/(n – r)! 
   nCr = nCr /r!  =  n(n–1)(n–2)…(n–r+1)/r!

♦ DISCRETE PROBABILITY DISTRIBUTIONS

Rectangular: 
 X ~ R(a, b)                          r = a, a+1, ... , b 
 P(X = r)   =  1/(b – a + 1) 
 Mean, μ   = (a + b)/2 
 Variance, σ²   = (b – a)(b – a + 2)/12 
Binomial: 
 X ~ B(n,p)   q = 1 – p  
  P(X = r)   = nCr p^r q^(n–r)   r = 0,1,2,3, ..., n 
  Mean, μ   = np  
  Variance, σ²  = npq  
Poisson:
 X ~ Poi (λ)   λ > 0  
  P(X = r)   = e^(–λ).λ^r/r!       r = 0,1,2,3, ... 
  Mean, μ   = λ 
  Variance, σ²  = λ 

Geometric:
 X ~ G(p)    q = 1 – p 
  P(X=p)   = q^(r–1).p  r = 1, 2, 3, ... 
  Mean, μ   = 1/p  Variance, σ²  = q/p² 

User-defined discrete probability distribution: 
 Mean,    μ  = Σr.P(x=r)  r = 0,1,2,3 ...
  Variance, σ²  = Σr².P(X=r) – μ²  

♦ CONTINUOUS PROBABILITY FUNCTIONS

Uniform:
 X ~ U(a,b)  a ≤ x ≤ b  
 Mean,       μ  = (a + b)/2 
  Variance, σ² = (a – b)²/12 

Normal:  X ~ N(μ, σ²) 
  pdf: f(x)  = 1/(σ√(2π)).e^(–½((x – μ)/σ)²)  
 Mean = μ   Variance = σ²  

Normal:  Z  ~ N(0, 1) 
  pdf: φ(z)  = 1/√(2π).e^(–½z²) 
  Mean = 0   Variance = 1  

Normal approximations (for suitable n, p and λ):
 B(n, p)  ≃ N(np, npq) 
  Poi(λ)  ≃ N(λ, λ) 

User Defined pdf: X ~ f(x) 
 Mean, μ  = ∫x.f(x) dx 
  Variance = ∫x².f(x) dx – μ² 

♦ Central Limit Theorem
For samples of size n drawn from a distribution with 
mean, μ and finite variance, σ², the distribution of the 
sample means  tends to N(μ, σ²/n) as n increases.

Statistics Formulae
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♦ 1ST ORDER DIFFERENTIAL EQUATIONS

Equations can be entered implicitly and rearranged as
   y’ = f(x,y)
We enter the initial conditions: (x1, y1) for which the 
gradient is now known: 
   g1 = f(x1, y1). 
We need to find a reliable estimate for the next point 
(x2, y2) using a step h.  We have: 
   x2 ≃ x1 + h and y2 ≃ x1 + h.g1
Hence:  g2 ≃ f(x2, y2)

A better estimate (Runge–Kutta) is: 
   y2 ≃ y1 + h.(g1 + g2)/2
Set h too large (inaccurate) and too small (slow).

♦ 2ND ORDER DIFFERENTIAL EQUATIONS

Equations can be entered implicitly and rearranged as
   y”  = f(x, y, y’)
We enter the initial conditions: (x1, y1) and y’1
We need to find a reliable estimate for the next point 
(x2, y2) using a step h.  
We have   x2 ≃ x2 + h 
and    y”1 ≃ f(x1, y1, y’1)
and    y2 ≃ y1 + h.y’1 + ½h².y”1 
   [Taylor’s Series, 1st 2 terms]
Hence:  y’2 ≃ y’1 + h.y”1 
and    y”2 = f(x2, y2, y’2)

A better estimate for y2 is (Runge–Kutta–Butler):
  y2 ≃ y1 + h.(y’1 + y’2)/2 + ½h².(y”1 + y”2)/2

♦ 1ST ORDER PARAMETRIC D.E.

When implemented, equations will be entered in 
parametric form: x’ = f(x, y, t), y’ = g(x, y, t) [or the other 
way round].  We have to enter the initial conditions: 
(x1, y1) at t = t1 for which the two gradient functions are 
known:
   x’1 ≃ f(x1, y1, t1)
   y’1 ≃ g(x1, y1, t1)
We have   t2 ≃ t1 + h 
and    x2 ≃ x1 + hx’1, y2 ≃ y1 + hy’1
Hence:  x’2 ≃ f(x2, y2, t2)
   y’2 ≃ g(x2, y2, t2)

A better estimate for (x2, y2) is (Runge–Kutta):
   x2 ≃ x1 + h(x’1 + x’2)/2
   y2 ≃ y1 + h(y’1 + y’2)/2

♦ TRAPEZIUM RULE

           h = (b – a)/n with n strips  x1 = x0 + h
     Area ≃ (h/2)(y0 + 2(y1 + y2 + . . .) + yn)
Volume  ≃ Sum of (πh/3)( ([f1(x0)² + [f1(x0)] [f1(x1)] 
   + [f1(x1)]²) – ([f2(x0)² + [f2(x0)] [f2(x1)] 
 + [f2(x1)]²) )
 for x0 from xmin to xmax – h

♦ SIMPSON’S RULE

           h = (b – a)/n with n strips (n, even) x1 = x0 + h
     Area  ≃ (h/3)(y0 + 4y1 + 2y2 + 4y3 + . . . + yn) 
Volume  ≃ Sum of (π(h/2)/3) ( ([f1(x0)² 
   + 4[f1((x0+x1)/2)²] + [f1(x1)]²)    
   – ([f2(x0)]² + 4[f2((x0+x1)/2)] + [f2(x1)]²) )
  for x0 from xmin to xmax – h

♦ CENTROID of area under y = f(x)

A = ∫ y dx        .A =  ∫ x.y dx      .A =  ∫½ y² dx
NOTE: this method will break down if any of the area is 
of different sign.

♦ MACLAURIN EXPANSIONS

 e = 1 + x + x²/2! + x³/3! + . . .  [all x]  
 ln(1 + x) = x – x²/2 + x³/3 – x⁴/4 + . . .  [–1 < x ≤ 1] 
 (1 + x) =  1 + nx + n(n–1)x²/2! + . . .  [|x| ≤ 1] 
 (1 – x) =  1 + x + x² + x³ + x⁴ + . . .  [|x| ≤1] 
 sinx =  x – x³/3! + x⁵/5! – . . .  [all x] 
 cosx =  1 – x²/2! + x⁴/4! – . . .  [all x] 
 arctanx =  x – x³/3 + x⁵/5 – . . .  [–1 ≤ x ≤ 1] 
 sinhx =  x + x³/3! + x⁵/5! + . . .  [all x] 
 coshx = 1 + x²/2! + x⁴/4! + . . .  [all x]
 artanhx = x + x³/3 + x⁵/5 + . . .  [–1 < x < 1]

Numerical Methods
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♦ LOGARITHMS AND EXPONENTIALS
 y =  e  => x = lny  
 x =  e^(lnx)  
 ln(e) =  x 
 logax =  logbx/logba
   So to enter logb(x), use log(x)/log(b)  

♦ TRIGONOMETRY

 cos²θ + sin²θ =  1 
 sec²θ =  1 + tan²θ 
 cosec²θ =  1 + cot²θ 

 sin2θ =  2sinθ cosθ 
 cos2θ =  cos²θ – sin²θ  
 cos2θ =  1 – 2sin²θ  
 cos2θ =  2cos²θ – 1 
 tan2θ =  2tanθ / (1 – tan²θ) 

 sin²θ =  ½(1 – cos2θ) 
 cos²θ =  ½(1 + cos2θ) 

 sin(θ + φ) =  sinθ cosφ + cosθ sinφ 
 sin(θ – φ) =  sinθ cosφ – cosθ sinφ 
 cos(θ + φ) =  cosθ cosφ – sinθ sinφ 
 cos(θ – φ) =  cosθ cosφ + sinθ sinφ 

 tan(θ + φ) =    (tanθ + tanφ)/(1 – tanθ tanφ) 
 tan(θ – φ) =    (tanθ – tanφ)/(1 + tanθ tanφ) 
 sinA + sinB =    2sin½(A + B) cos½(A – B) 
 sinA – sinB =    2cos½(A + B) sin½(A – B) 
 cosA + cosB =    2cos½(A + B) cos½(A – B) 
 cosA – cosB =  –2sin½(A + B) sin½(A – B) 
 

 cosx =  sin(90 – x)  
 cosecx =  sec(90 – x) 
 cotx =  tan(90 – x) 
 sinx + cosx =  90°, etc 
 cosec(x/a) =  sin(a/x), etc 

♦ RADIANS AND DEGREES
----------------------------------------------------------------------
Rad:  0  �/6  �/4  �/3  �/2  � 
Deg:  0°  30°  45°  60°  90°  180° 
----------------------------------------------------------------------
sinθ:  0  1/2  1/ /2  1    0 
cosθ:  1  /2  1/  1/2  0  −1 
tanθ:  0 1/ 1  ∞    0 

♦ DIFFERENTIATION

 f(x)  f‘(x) 
==========================================
 xn   nx^(n–1) 
 ex   ex 
 lnx   1/x 
 ax   ax.lna 

 sin(kx)     kcos(kx)  
 cos(kx)   –k.sin(kx) 
 cosx   –sinx  
 tanx     sec²x 
 secx     secx tanx 
 cotx   –cosec²x 
 cosecx   –cosecx cotx 

 arcsinx     1/√(1 – x²) 
 arccosx   –1/√(1 – x²) 
 arctanx     1/√(1 + x²) 
 arcsecx     1/(√(x² – 1).|x|) 
 arccosecx   –1/(√(x² – 1).|x|) 
 arccotx   –1/(x² + 1) 

 sinhx     coshx  
 coshx     sinhx 
 tanhx    sech²x 
 sechx   –sechx tanhx 
 cosechx   –cosechx cothx 
 cothx   –cosech²x 

 arsinhx     1/√(1 + x²) 
 arcoshx     1/√(1 – x²) 
 artanhx     1/(1 – x²) 
 arsechx   –1/(x√(1 – x²)) 
 arcosechx   –1/(|x|√(1 + x²)) 
 arcothx     1/(1 – x²) 

Pure Mathematics Formulae
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♦ INTEGRATION

 f(x)   ∫f(x) dx   [+ c, constant]
==========================================
 xⁿ  x^(n+1)/(n+1)  [n ≠ 1] 
 1/x   ln|x|
 e e 
 a  a/lna 
 lnx   x.ln|x| – x 

 sin(kx)  –(1/k)cos(kx) 
 cos(kx)  (1/k)sin(kx) 
 tanx   ln|secx| 
 secx   ln|secx + tanx| = ln|tan(½x+¼π)| 
 cosecx   ln|tan½x| 
 cotx   ln|sinx| 

 sinx  x.sinx + √(1 – x²)
 cosx   x.cosx – √(1 – x²) 
 tanx   x.tanx – ½ln|1 + x²| 
 secx   x.secx – ln|x + √(x² – 1)| 
 cosecx   x.cosecx + ln|x + √(x² – 1)| 
 cotx   x.cotx + ½ln|1 + x²| 

 1/√(a² – x²)   arcsin(x/a)   [|x|< a]
 1/(a² + x²)   (1/a)arctan(x/a) 
 1/(a² – x²)   (1/a)artanh(x/a) 
  = 1/(2a)ln|(a+x)/(a–x)| 
 1/√(x² + a²)   arsinh(x/a) 
  = ln((x + √ (x² + a²))) [a > 0] 
 1/√(x² – a²)   arcosh(x/a) 
  = ln((x + √ (x² – a²))) [x ≥ a] 

 e^(ax) sin(bx)   e^(ax)/(a²+b²) (asinbx – bcosbx) 
 e^(ax) cos(bx)   e^(ax)/(a²+b²) (acosbx + bsinbx)

 sinh(x) cosh(x) 
 cosh(x) sinh(x)
 tanh(x) lncosh(x)
 sech(x) arctan (sinh x)
 cosech(x) ln |tanh(x/2)| 
 coth(x) ln |sinh x|

 arsinh(x) x arsinh(x) – √(x² + 1)
 arcosh(x) x arcosh(x) – √(x² – 1)
 artanh(x) x artanh(x) + ½ln(1 – x²)
 arsech(x) x arsech(x) + arsinh(x)
 arcosech(x) x arcosech(x) + arsinh(x)
 arcoth(x) x arcoth(x) + ½ln(x² – 1) 

The Chain Rule in reverse:
∫ du/dx.f(u) dx = ∫ f(u) du

Integration by parts:
∫uv dx = v.I – ∫ I.dv/dx dx where I = ∫udx

Chain rule: y = f(u)  dy/dx = dy/du.du/dx 
Product rule:   y = uv  dy/dx = v.du/dx + u.dv/dx 
Quotient rule:   y = u/v  dy/dx = (v.du/dx – u.dv/dx)/v² 
____________________________________________

♦ 3D FORMULAE

Equation of a plane:  
 r.n  = d
 [x, y, z].[a, b, c]  = d
 ax + by + cz  = d
 [x, y, z]  = [a, b, c] +  λ[u, v, w] + μ[l, m, n]

Equation of line:
 [x, y, z]  = [a, b, c] +  λ[u, v, w]

Scalar Product:
 u. v  = |u|.|v|.cosθ

Vector Product:
 u x v  = |u|.|v|.sinθ.

Distance from point (α, β, γ) 
to plane ax + by + cz + d = 0
   = |aα + bβ + cγ + d|/√(a² + b² + c²)

Volume:  
 about x-axis  = ∫�y² dx
 about y-axis  = ∫�x² dy
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Example Equations

♦ CARTESIAN y=f(x)
y = 2x – 3 
y = mx + c  
y = (x – a)(x – b) 
y = x/(3 ± x) 
y = x ± √(3 + x) 
y = 27/(x² + 9) 
y = 2x/(x² + 1)  
y = (x² – 1)/x/(x – 2)  
y = (x² + 1)/(x² – 1) 
y = (1 – x²)/(1 + x²) 
y = ax² + bx + c  

then:   x = (–b ± √(b² – 4ac))/(2a) 
 and:   x = –b/(2a)
 
♦ CARTESIAN x=f(y)
x = y² – 4
x = (y – 2)(y + 5)
x = siny
x = 2
x = ln|y|

x² = siny
x³ = siny

♦ TRIGONOMETRIC
y = sin²x + cos²x 
y = cos2x  
y = sin²x 
y = cos²x  
y = |sinkx|
y = asin(nx + θ)
y = c sin(nx) + d cos(nx) 
y = sin20x + sin(nx) 
y = 2 sin(½(20 + n)x) cos(½(20 – n)x) 
y = tanx  
y = secx  
y = cosecx  
y = cotx  

♦ INVERSE TRIG   Use ALT-1 to enter the symbol 
.
y = sinx   = arcsinx 
y = cosx  = arccosx 
y = tanx  = arctanx 
y = secx  = arcsecx 
y = cosecx  = arccosecx 
y = cotx   = arccotx 
x = siny  

y = sinx + cosx  
♦ EXPONENTIAL

y = a
y = xⁿ
y = e
x = lny
y = ae^(–bx)sin(cx + d)
y = e/(1 – e)
y = e^(–x²)
y = 1/√(2π)e^(–½x²)
y = ln|x|
y = ln|(1 – x)/(1 + x)|
y = logx
y = lnx/x

♦ HYPERBOLIC      
Use ALT-1 to enter the symbol ‘’.

y = sinhx   = (e – e)/2  
y = coshx   = (e + e)/2 
y = tanhx   = sinhx/coshx 
y = sechx   = 1/coshx 
y = cosechx  = 1/sinhx 
y = cothx   = 1/tanhx 

y = sinhx  = arsinhx 
y = coshx  = arcoshx 
y = tanhx  = artanhx 
y = sechx  = arsechx 
y = cosechx  = arcosechx 
y = cothx  = arcothx 
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♦ IMPLICIT REARRANGABLE
These are rearranged internally as y = f(x). If the 
equation contains ‘±’, the graph is treated as two 
separate functions, a ‘positive’ and negative’ branch.
 2x + 3y  = 6 
 2x² + 3y² = 6 
 y² = x³ + x² 
 y²  = x²(1 – x²)³ 
 y²  = x(4 – x)   and  y = x(4 – x) 
 y²  = (x – 1)³/x  
 y²  = x(x – 2)²/(4 – x) 
 y²   = x(4 – x)(x – 2)² 
 y²  = x(x² – 3) + c  
 y³  = 1 + x 
 x³ + y³  = ±1 
 x³ – y³  = ±1

♦ CONICS
Note: Autograph uses ‘e’ in the context ‘ex’, so another 
letter needs to be used in equations for eccentricity.

Circle  (x – a)² + (y – b)² = r²    Centre: (a, b)
[e = 0]  x² + y² + 2gx + 2fy + c = 0 
 Centre:  (–g, –f)  r² = g² + f² – c 

Ellipse  x²/a² + y²/b² = 1 
[e < 1] x = acosθ, y = bsinθ  
  Focus: (± ae, 0)  
 Directrices: x = ±a/e 

Parabola  y² = 4ax   Focus: (a, 0)
[e = 1]  x = at², y = 2at 
 Directrix:  x = –a 

Hyperbola  x²/a² – y²/b² = 1  
[e > 1]  x = asecθ, y = btanθ 
 Focus:   (±ae, 0) 
 Directrices: x = ±a/e  
   
Rectangular Hyperbola  xy = c² x = ct, y = c/t 
[e = ]  x = ct, y = c/t 
 Focus:  (±c, ±c) 
 Directrices:  x + y = ±c 
 Asymptotes:  y = ±(b/a)x

Polar Conic 1/r = 1 + kcosθ 
[e = k]  

General  ax² + 2hxy + by² + 2gx + 2fy + c = 0 
♦ GENERAL IMPLICIT
These cannot be re-arranged or analysed as y=f(x) and 
are plotted using a sampling process.
 sinx + cosy   = k 
 sinx   = cosy 
 xy² – x – y   = k 
 x^y   = y^x 
 x³ + y³   = 3xy 
 (x² + y²)²   = x² – y² 
 (x – y)(x + y)  = 0 
 x² + 2hxy + y²  = 9 
  (x² + y² – 4) + k(2x – 3y + 2)  = 0 
   a(x²/9 + y²/4 – 1) + b(x + y + 1) = 0 

♦ FUN EQUATIONS
 y  = xsin(1/x) 
 y  = sinx/x 
 y  = int(x) 
 y  = |x| ± Ä(1 – x²)
   x² + (y – mx²)² = 1 
  x⁴ + x²y² + y⁴ = x(x² – y²) 
 (2y – x)²  = xcotx   
 and   2y – x = 0 
 xy  = x³ ± 1 
                y  = 2(x² + |x| – 6)/(3(x² + |x| + 2)) ± Ä(36 – x²) 

♦ INEQUALITIES
Use “View” => “Preferences …” to set whether the 
‘accept’ or the ‘reject’ region is shaded. The default 
shades the ‘reject’ region, leaving the ‘accept’ region 
clear to mark solution points by adding points.

Straight Lines y < 3x + 1  x ≥ –2 
 2x + 3y  ≥ –3  y < x² 
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Other x² + y²   < 16 
♦ FUNCTION DEFINITIONS
Use the button or the Function Definitions entry in the 
Equation menu.
f(x) = sinx     then   y = f(–x)
 y = f(|x|)
 y  = f(f(f(x)))
f(x) = x²    with  g(x) = (f(x + h) – f(x – h))/(2h)
 then 
y   = g(x) for various ‘h’

♦ PARAMETRIC EQUATIONS 

Parameter time (‘t’):
 x  = at², y = 2at
 x  = ut, y = vt – gt² 
 x  = 18t – 1.5t², y = –24t + t²

Trigonometric (‘t’ or ‘θ’)  [use ALT–T to enter θ]
 x  = sin2t, y = cost
 x  = sin(at), y = cos(bt)
 y  = asin(nθ), x = bcos(nθ) 
 x  = t – sint, y = 1 – cost   [Cycloid]
 x  = t – 2sint, y = 1 – 2cost  [Prolate cycloid]
 x  = 7cost – cos7t, y = 7sint – sin7t [Epicycloid]
 x  = sint, y = sin(t + 30)   [in degrees]
 x  = 2cot(t), y = 2sin²(t)   [Witch of Agnesi]
 
♦ POLAR EQUATIONS  [use ALT T to enter ‘θ’]
 r  = 2cos4θ   
 r  = sinθ         [circle] 
 r  = secθ         [straight line] 
 r  = ±2sin2θ
 r  = 1, with θ-step = 90°  [Square]
 r  = 3/(2 – cosθ)       [Ellipse] 
 r  = 1 – cosθ        [Cardiod] 
 r  = e^(θ/4)  
 1/r  = 1 – kcosθ       [see Conics]  
 r²  = θ/20         [Fermat’s spiral] 
 r²  = cos2θ        [Lemiscate of Bernoulli] 
 r²  = lnθ

Polar ‘radials’ can be entered in the form θ = ...: 
 θ  = nπ/8   and   r = cos(8θ) [n = 1 to 8]  

♦ PIECEWISE EQUATIONS
Use the equation entry startup options to enter the left 
hand limits and final for each segment of the equation:
 y  = –1, cosx,1    

Startup options: [–2, –π/2, π/2, 2]
♦ EVOLUTES
Parent       Evolute 
y = x²/4        [Parabola] => x² = (4/27)(y – 3)³ 
x²/4 + y²/1 = 1  [Ellipse] => (2x/3)^(2/3) + (y/3)^(2/3) = 1 
x² – y² = 1  [Hyperbola]  => (x/2)^(2/3) – (y/2)^(2/3) = 1 

♦ 1st ORDER DIFFERENTIAL EQUATIONS
Explicit:  y’  = –x/y 
 y’  = x+y 
 y’  = 2xy/(x² – y²) 
 y’  = sin(xy) 
 dy/dx  = y 

Implicit:  y’ + ky  = 1 
 y’ + y  = x 
 y’ + y  = 2sinx 

With axes reset to x-t: x’ enters ẋ, eg: 
 ẋ + x  = 2sint 

♦ 2nd ORDER DIFFERENTIAL EQUATIONS
With axes reset to y-x: 
 y”  = 1 
 y”  = y 
 y” + 2ky’ + y  = 0 
 y” + 2ky’ + y  = x 

With axes reset to x-t: x’ enters ẋ, x” enters ẍ, e.g.: 
 ẍ  = –10  
 ẍ + n²x  = 0  [SHM] 
 ẍ + 2λẋ + n²x  = 0    [Damped SHM]
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♦ 3D: z = f(x, y)
 z  = asinxcosy  [Egg Box]
 z  = x² + y²  [Paraboloid]
 z  = x² – y²  [Saddle]
 z  = xy   [Saddle]

Linear equations that can be rearranged to z = f(x, y):
     ax + by + cz  = d     Plane, ⊥ vector [a, b, c]

♦ 3D: IMPLICIT
Created using a scan of the bounding cube. The 
resulting surfaces are not available for any calculations, 
and points cannot be placed on their surface.

Second-degree equations:
   x² + y² + z²   = r²  [Sphere]
   x²/a² + y²/b² + z²/c²  = 1  [Ellipsoid]
   z² + y²  = x²  [Cone, axis: x–axis]
   x² + z²  = y²  [Cone, axis: y–axis]
   x² + y²  = z²  [Cone, axis: z–axis]
   y² + z²  = r² [Cylinder, axis: x–axis]
   x² + z²  = r²  [Cylinder, axis: y–axis]
   x² + y²  = r²  [Cylinder, axis: z–axis]
  xyz – yz – xz – xy + x + y + z  = 1  [Three planes]

   x² + y² + a  = z²  [Hyperboloid]
   x² + y²  = a²(cosh(z/a))²      [Catenoid]
   z² + (Ä(x² + y²) – b²)²  = a²  [Torus]

Other implicit equations:
   cosx + cosy + cosz  = 0  [Schwarz’s P surface]
   |x| + |y|  = r [Box]

  cosxsiny + cosysinz + coszsinx = 0  [Gyroid]
   e^zcosx – cosy   = 0 
   |xyz|  = a

CONIC SECTIONS:  
Note - the Cone can be input as 
   r = z   (cylindrical coordinates).

   z = 2  [Circle]
   z  = 2+x/2 [Ellipse]
   z  = 2+x  [Parabola]
   z  = 2+2x  [Hyperbola]
   x  = 2  [Rect. Hyperbola]
   x  = 0  [Two Lines]
   z  = x  [One Line]
   z  = 0  [Point]

♦ 3D: PARAMETRIC  
[ALT T = ‘θ’]

  x = t,  y = ±t, z = 0      [pair of straight lines]
  x = sinθ, y = cosθ, z = θ   [spiral]
  x = a + kcosθ, y = θ, z = b + ksinθ

♦ 3D: SPHERICAL POLARS 
[ALT T = ‘θ’, ALT F = ‘φ’]

  r = 1        [sphere]
  r = 3sin2θ

Spherical polar equations may be entered 
parametrically:  x = f(θ,φ), y = f(θ,φ), z = f(θ,φ)

  x = a + kcosθ, y = φ, z = b + ksinθ
      [offset cylinder, radius ‘k’]
  x = (c + acosφ)cosθ, y = (c + acosφ)sinθ, z = asinφ
     [Torus: radius ‘c’, sub–radius ‘a’]
  x = (2 + 0.2sinπθ)sinπφ, y = 0.2cos2πθ + 3cos2πφ,
       z = (2 + 0.2sin2πθ)cosnπφ    [Lissajous]
  x = ksin(θ)sin(φ),  y = kcos(θ), z = ksin(θ)cos(φ)
      [Sphere]

 
3D: CYLINDRICAL POLARS 
[ATL T = ‘θ’]

  r = 1    [cylinder]
  r = 1    [triangular prism, θ–step set to 2π/3]
  r = 1    [triangular box, θ–step set to π/2]
  r = z    [cone]
  r = (1–0.25z²)(1 + 0.5sin(1.5πz) + 0.3cos5θ)
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Adjusting for the Visually Impaired

1. Using Windows accessibility facilities:  
Start => Programs => Accessories => Accessibility. 
Use the Accessibility Wizard, or the Magnifier or Narrator 
options.

2. Make Autograph Toolbar icons bigger:
Right-click over the toolbars 
=> “Customize” => “Options” => tick “Large Icons”.

3. Make the Autograph axes more visible:
Use “Axes” => “Edit Axes” => “Appearance”.  
Here you can make the axes numbers, the axes labels 
and the equation list much easier to read by setting the 
font size, say, to 18pt and bold. Also the axes and grid 
lines can be thickened up.

It is suggested that users save  three  files “Blank-1”, 
“Blank-2” and “Blank-3” for each of the 1D, 2D and 
3D pages, each set up for ideal visibility.  Load the 
appropriate file at the start of each new session.

4. Make the Autograph plotting thicker:
Whereas Axes Appearance is set for each page (hence 
the suggestion to save ‘blank’ pages), it is possible to set 
the general line thickness for all pages created by the 
current user.

Use “View” => “Preferences” => “Plotting” and tick 
“All Thick Lines”. A setting of 4½pt will make all plotted 
lines and curves more visible.
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Autograph 3.20 on an Apple Mac

Power PC Based Mac

Autograph 3.20 will install and run on an Power PC 
Based Mac by making use of the Virtual PC application, 
published by Microsoft. This is a Windows Emulation 
program. It lets your Mac run Windows. If you already 
have a licensed installer for Windows then you can just 
buy Virtual PC on its own. If you don’t then you can buy 
Virtual PC bundled with Windows XP. 

It’s simple to drag and drop files between the two 
environments. So you can capture Autograph screens 
and incorporate them in Mac documents. The 3D 
facilities do not work with the current version of  Virtual 
PC and Microsoft have stated they will not be bringing 
out any future versions.

Intel Mac

Parallels Desktop allows you to run Windows on Mac OS 
X without rebooting. Codeweavers produce CrossOver 
which allows you to install Windows applications directly 
on your Mac. However, 3D facilities are not expected to 
work using either of these methods. 
 
Apple’s Boot Camp software allows you to run Windows 
on your Mac but you must restart the computer to switch 
operating systems. It is expected that 3D facilities will 
work using this method.

Citrix and MS Terminal Server

This is a network solution, running Autograph on a PC 
Server, and using Macs as thin clients. It works, but 
there may be concerns about speed and, again, difficulty 
with the implementation of the 3D facilities.

Using the Apple Mouse

The Standard Apple mouse has only one button, which 
is the equivalent to the PC LEFT CLICK button. Also, 
there is also no roller on the mouse.

It is possible to plug in a standard PC mouse to a Mac 
with OS X, but for a single-button mouse, you can use 
this conversion table when reading this manual: 

PC Mouse/Keys MAC Mouse/Keys
==========================================
RIGHT-CLICK CTRL-CLICK or ALT-CLICK
    or use the ‘OBJECT’ Menu
CTRL-CLICK APPLE-CLICK

SHIFT-CLICK SHIFT-CLICK
CTRL-any key APPLE-any key 
    e.g. Apple-C =  COPY, etc
ALT-any key CTRL-any key
    e.g. Ctrl-. = Point mode
==========================================
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